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Part 1: Visual Trading Platform Functions & Features 
 
I. Introduction 

  
 1. Overview 

 
The Visual Trading System software is an innovative, convenient and powerful tool, yet it is 

easy to use. The software enables a trader to perform a multitude of tasks, including chart drawing, 
application of technical tools, placement of orders, position analysis and control. Moreover, the 
Indicator Builder – a unique, totally new and exclusive feature of VT Trader – permits the user to 
design customized trading systems. 

The VT Trader software package is frequently updated. Users will be notified of such updates 
and will be able to use them immediately. 

One of the major advantages of trading with Capital Market Services, LLC is that there is no 
fee or any other charges at all for using the VT Trader software. Regardless of whether you have 
opened a demo or live trading account, the service is completely free and available to everyone.  

 
2 The Starting Point 
 
The dealing station is an online application that enables the user to trade foreign currency 

contracts on the spot market. In addition, it provides important auxiliary functions such as: 
   

• Instant direct access to account status 
• Real-time dealing rates  
• Charts 
• Technical analysis tools 
• Live news feed 
• Detailed reports and summaries of all transactions 

 
The Navigation Window is your primary tool for navigating through VT Trader’s many features. 

You can select trading windows, open charts, layers and technical studies, including the Indicator 
Builder.  

When you log in for the first time you can choose the “Arrange by Default” option from the 
“Windows” drop-down menu on the toolbar of the Navigation panel. 

However, you can customize the main screen to include any reasonable number and 
combination of windows. For example, you may substitute all auxiliary windows with chart panels for 
different currency pairs, or the same one but reflecting different time periods (from tick-by-tick to 
monthly). You should find which main screen setup works best for you. 

The green light at the bottom of the Navigation Window indicates that your PC is securely 
connected to the remote server. The light changes to red if the connection is lost. 

If, for example, your Internet service provider experienced technical difficulties and the 
connection was lost, the user would be momentarily notified by a pop-up box.  
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3. How to log in/log off 
 

To activate Visual Trading, whether it’s a demo or live trading account, just double click on the 
VT Trader icon on your desktop or start it from the program list on the Windows Start menu. 

A Login box will appear on your screen. Enter your login and password. Keep in mind that your 
login and password are both case sensitive. Do not forget to select Demo or Live trading and specify 
language. English is the default setting. After you click “Ok” and your login information is verified, the 
Navigation Window will be launched.  
 
 

 
 

To log off simply choose “File” from the Navigation Window menu > “Log off’.  
. 
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4. Main client screen 
 

 
 
 
 
Dealing Rates Panel (1) – Shows current Bid and Ask prices for all traded currency pairs 
Navigation window (2) – Lets the user bring up other panels, select different charts, apply 

technical analysis tools and determine properties of the system components 
Chart window (3) – Displays the appropriate chart that the user has selected. You can 

open/close positions and apply studies by right-clicking on the chart.  
Activity Log (4) – Contains all information regarding the trader’s order requests and 

confirmations    
Orders list window (5) – Displays pending orders  
Account information (6) – Lists account balance, equity, used and unused margin, and net 

profit/loss  
Other windows (not shown above) include: Reuters news window, Summary by Account(s), 

Forex news and Reports. 
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II. System functions 
 
1. How to place an order 

 
You can place an order by right-clicking anywhere within the chart. An options box will appear. 

When an order is placed, an Open Position box appears, prompting the user to specify the amount of 
currency he or she wishes to trade:   
 

 
 
 
 “Amount per Acct” refers to how many standard lots you want to trade (if you enter 1, you are 
specifying 1 lot or 100,000 units of the specified currency). You can trade mini lots by entering in 
decimals (e.g. for 1 mini lot of 10,000 units, you would enter 0.1, for 5 mini lots, you would enter 0.5, 
etc.).   
 “Trader’s Range” is a feature that allows you to specify the maximum number of pip deviation 
from the current price (in either direction) that you will accept. “Trader’s Range” is set to 0 by default. 
This is a very useful feature to have in a fast moving market to try to reduce the risk of getting 
requoted.     

Notice that the rate is preset since it follows the market rate. The request by the user to place 
an order is confirmed in the Activity Log window: 
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If an Entry Limit Buy or Entry Stop Sell order is placed you must specify, in addition to the 
amount, the rate and duration of the order (Day or Good Till Cancelled – GTC). 
 If the user has only one account, it will be checked off by default. However, if there are several 
accounts you must check off only the account that you intend to trade. Those accounts that are not 
marked will not be affected at all. This applies to all types of orders. 
   
 

 
 
 Important note: If you have several accounts, you must check off those accounts that you will 
trade in the Account(s) Information window in order to see his accounts in the Open Position box 
when you intend to place a trade.  
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Entry orders are reflected graphically in the Charts window as a colored line with a callout 
showing type of order, ticket number, amount and rate of the currency being traded: 
 
 

 
 

You may drag the callout to a convenient location on the chart with the mouse; change its 
color, shape, etc. Right-clicking on the open order callout opens a box with the options to change or 
remove that order. 

 
 
2. Non-market order types  
 
Limit orders 
 
Limit orders are executed if the market price reaches a price specified at any time while the 

order is in effect. They are generally used when the trader expects that the market price will reach a 
certain level and rebound. Because the market price may not reach the specified level, there is no 
guarantee that a limit order will be executed. Limit orders are executed at the specified price only. For 
example, the limit price must match the ask price for a buy limit order to be executed. Limit orders 
remain open until they are executed or canceled by the trader.  

 
Stop orders 

 

 
Stop orders are generally used when the trader expects the price to reach a certain level and 

continue moving in the same direction. Stop orders are therefore executed only if the market price 
breaks through the price specified. As with the Limit orders, there is no guarantee that stop orders will 
be executed. Also, stop orders are not always executed at the price specified in the order. The 
execution price may differ by several pips from the price requested. 
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Example: The trader has placed a market order to buy 1 lot of EUR/USD at 89.94 and the 
order is executed at that price. To limit his losses, the trader places a stop order at 89.54. If 
EUR/USD begins trading at 89.51 Bid and 89.55 Ask, the Stop order is triggered and becomes a 
market order to sell 1 EUR/USD lot. If EUR/USD then moves lower before the live order gets 
executed, the order may be executed at 89.52, i.e. 2 pips below the price specified. If the Ask price 
reaches the 89.54 level but does not break through it, however, the stop order will not be executed.   
 

 
3. Navigation window 
 
As mentioned earlier, the Navigation window opens automatically when you log into the VT 

Trader system and is always located in the left side of the screen. 
The Navigation window provides direct access to charts, technical analysis indicators, and 

various trading and auxiliary functions. The platform allows you to choose between opening several 
widows at once and switching from one window to another. For example, a trader may decide to open 
several charts of the same currency pair but for different time intervals.  

The user can resize the Navigation panel by holding the cursor over the window’s borders and 
dragging them into the desired location.   

The right-side bar menu provides buttons for easy access to many features. The functions of 
the right-side bar are discussed below:  
 
 
 
 
 4. Functions of the Right-Side Bar Menu   
 

         This “pin” button, if pressed, will remove the Navigation Window from the screen. To restore 
the screen, hold the mouse for about 20 seconds over the left side of the computer screen. This 
feature is called “Autohide.”          
 
 

        When you click on this button the Navigation Window will be minimized. To restore the 
window, click on this button one more time. 
 
 

           Clicking on this icon arranges all windows in a mosaic fashion 
 
 

           Clicking on this icon arranges all windows in a horizontal fashion. 
 
 
 

      Clicking this icon allows you to remove and restore the graph lines on the chart. 
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       These icons allow the user to zoom in and out, horizontally and vertically 
 
 

 “Autoscroll” to current time and “Autosize” vertically 
 
  

These icons allow you to choose which of the following chart types to view: 
• Candlestick 
• Outlined Candlestick 
• Bar chart 
• Uninterrupted Bar Chart 
• Close connected line chart 

 
 

 Selects a tick-by-tick chart 
 

 Selects a 1 minute time interval chart 
 

 Selects a 5 minutes time interval chart 
 

 Selects a 10 minutes time interval chart 
 

 Selects a 15 minutes time interval chart 
 

 Selects a 30 minutes time interval chart 
 

 Selects a 60 minutes time interval chart 
 

 Selects a 2 hour time interval chart 
 
 

 Selects a 4 hour time interval chart 
 

 Selects a day chart 
 

 Selects a one week chart 
 

 Selects a One month chart 
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These icons are, from top to bottom: 
 

• Pick tool 
• Copy price 
• Trend line  
• Comments 
• Symbols 
• Fibonacci Retracements Horizontal 
• Fibonacci Projections Horizontal 
• Fibonacci Retracements Vertical 
• Fibonacci Projections Vertical 
• Fibonacci Retracements Angled  
• Fibonacci Projections Angled 
• Regression Line 
• Vertical Line 
• Horizontal Line 
• Delete 
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5. Trading and Options functions. 
 

The Navigation Window contains two main folders: Trading and Options. 
 

                                                           
 

The Trading folder remains open by default. The inside of this folder includes three column 
names with plus boxes next to each one. 
 
                                                          

 
 
 

Clicking on the plus box expands the contents of each column, for example: 
 
 

 
 

By clicking on the entries in the upper column you can open other widows, such as dealing 
rates window, account information window, etc.  
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The expanded charts column provides a choice of 18 currency pairs for which to open charts: 
 

 
By clicking the plus symbol next to any currency pair in the Trading folder of the Navigation 

window, you will be able to see a selection of time periods for the specific currency pair being 
researched – from a tick-by-tick chart to a one month chart. Also, you may choose chart type, such as 
a candlestick chart or a simple line chart. 
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The options folder of the Navigation pane allows you to choose the color of charts, fonts, line 
width, etc. for all other windows. More detailed information about this feature may be found in the 
Properties section of this manual.   
 
 6. Technical Indicators 
 

When expanded, the studies column provides 37 technical indicators to choose from: 
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Particular indicators are applied by selecting and clicking on the appropriate entry in the list 
above. The Indicator Properties window will appear and let you change the properties or leave them 
at the default settings. For example, the default setting for the Moving Average (MA) indicator is a 
period of 13 days; MA is simple (as compared to weighted and exponential MAs) and is calculated 
from closing prices.  
 

 
 

The default color is red, width zero and a simple line is used: 
 

 
  
 

These default settings may be changed to the figures and style of your choice. The “Set as 
Default” button at the bottom of the Indicator Properties box lets you apply custom settings on a 
permanent basis, without entering properties each time the indicator is applied. 
 

Click on the “OK” button if you are satisfied with the default properties or have changed them 
to be used one time only. The technical indicator will be applied to the chart.  
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7. How to choose the best layout 
 
 Depending on the type of tasks used, some windows may be expanded to full screen and the 
others collapsed or entirely closed.  
 Before opening positions you may want to monitor several chart panels instead of the Activity 
Log, List of Orders, Accounts and Summary of Account(s) windows. Most of the technical indicators 
simply cannot be seen on a small screen and in order to use them effectively, the chart panel may 
need to be expanded. 

Conversely, after opening positions, you may want to focus on monitoring them in order to exit 
the market at the targeted price or depend on the stop order to cut losses if the market moves against 
you.  Consequently, you might want the layout to include only one chart window, activity log, list of 
orders, dealing rates and account(s) panels.  

At the end of the trading day or trading week, you may want to open reports to check your 
realized and unrealized profit or loss.  
 Non-essential windows may be closed simply by clicking on the cross symbol in the upper right 
corner of the window. The size of any window may be changed by holding the cursor over the window 
border and dragging it sideways. 
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III. System Features 
 

1. Chart window 
 

The chart window displays the price fluctuation of a currency pair in a chosen graphic format. 
There are two ways of modifying charts: the vertical menu on the sidebar of the Navigation window 
and the horizontal menu at the bottom of the Charts window itself.   

 
 

 
 
 

When you click the “Q” button in the lower right corner of the Chart window, a yellow box will 
displays the current two-way price (Bid and Ask) in the upper-left corner of the Chart window. To 
remove the quote box, simply click on the “Q” button again. 

The band on the chart that has a slightly different color than the background represents the 
spread, i.e. the difference between the Bid and Ask prices. 
 The menu bar at the bottom of the chart window includes several important features:  
 

 
 
From left to right, these buttons will allow you to: 
 

• Choose a different currency pair to view on the chart 
• Choose different chart time intervals 
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• Switch between charts that use Bid or Ask prices  
• Change the mouse pointer tool back to an arrow. For example if a pencil tool is used and the 

user wants to switch the cursor back to the pointer, he would press this button 
• Duplicate the menu in the right frame of the Navigation panel, allowing you to draw trend lines, 

include symbols, comments and apply Fibonacci analyses  
• Use the Inspect tool, making it possible to identify Open/Close/High/Low prices on a particular 

date and time while moving the cursor over the chart field 
 

 
 

• Use the “Clone Chart” button, making an exact copy of the existing chart 
 

This function is useful for applying a new set of technical indicators without changing the 
current setup. 

 
• Use the “All” button to select from multiple accounts 
• Shows margin call rates 
• Choose different chart types 
• Zoom out/ Zoom in 
• Use the “Q” button to show/hide the rate box in the upper left part of the Chart screen 

 
The green lights at the bottom of the chart screen indicates that the live data feed into the 

system is functioning properly. 
 

2. Price alerts 
 

You can set up a Price Alert to notify you in graphic and/or sound form by right-clicking on the 
chart window and choosing the “Price Alert” feature from the pop-up box. In the Price Alert box there 
are options to set the trigger for alert at a specified Bid/Ask price and choose a particular message or 
sound file. Alerts are displayed on the Chart window in the form of callouts. 
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3. Dealing rates window 
 
 

The Dealing Rates window can be viewed in two modes. 
In the regular (default) mode it shows Bid and Ask prices for each of the currency pairs traded.  

The last two digits of any quote are colored blue for an uptick and red for a downtick. 
 

 
 

In the Advanced mode, the Dealing Rates window contains, in addition to current Bid and Ask 
prices, the highs and lows for the day, as well as overnight interest charged or credited to the trader’s 
account. 

 

 
 



www.visualtradingsystems.com 

 

20

 In addition to using the chart field, orders can be placed by clicking in any of the price boxes in 
the default Dealing Rates window.  

 
4. Setting Properties 

 
The “Options” folder of the Navigation window contains a “Properties” entry. When the plus 

sign next to “Properties” is clicked, three additional sections will unfold: “General,” “Charting” and 
“Trading Windows”. 

The “General” screen allows the user to set General and cross hair properties: 
 

  
 

 
 

To change the properties of chart lines, including the borders and fills of candlesticks, from the 
Navigation window select Options - > Properties - > Charting - > Line and Fill. In the pop-up box 
choose the desired option: 
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Similarly, to change the properties of orders in their graphic depiction on the screen, select 
Options - > Properties - > Charting - > Orders - > Open Position (Entry, Stop, Limit, Market, etc.). For 
example: 

 

 
 

If you decide to change the properties of such objects as lines, trend lines, Fibonacci 
Retracements (Projections), Comments, Symbols and Linear Regression lines, select Options - > 
Properties - > Charting - > User Objects - > Line (Trend line, Fibonacci Retracements, etc.): 
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Finally, the “Trading Window” selection allows the user to change properties of Dealing Rates, 
Open Positions, Pending Orders, Account Information and Summary of Accounts windows, as well as 
Price Alert and Print Setup. Margins, font and effects can be adjusted to suit your needs: 
 

  
 
  
 Another way of changing Chart properties is to select the entry from the pop-up box that 
appears when you right-click in the chart field. The Chart Properties window (as shown below) 
prompts the user to change color, width and other specifications of labels, current rate line, rulers, 
spread band, high/low lines, and quotes board. 
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5. Activity log 
 

The activity log box informs you of all your requests and lets you know if and when each is 
confirmed.  
 
 

 
 
 When an order is placed, the Activity Log Window automatically opens to indicate that it has 
been relayed to the dealing desk. This is immediately followed by confirmation that the order has 
either been placed (for limit and stop orders) or executed (for market orders). Changes in status are 
accompanied by sound alerts.  
 

6. Open Position Window 
 
This window provides the VT Trader with information regarding all his open positions (ticket 

number, amount of currency traded, price, gross and net profit/loss, etc.).  
 

  
 
To place limit or stop orders, or to close positions, you may right click anywhere on the row 

representing a particular trade. Then choose the appropriate entry from the pop-up menu. 
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 7. Hedging 
 
To hedge (i.e. to open a position in the opposite direction of the initial position), choose 

“Hedge” from the pop-up menu brought up by right-clicking in the Open Position(s) Window. 
In the Open Position(s) pop-up window it is necessary to indicate the amount of currency 

hedged (see picture below). Make sure the Hedge box is checked.    
 

 
 
 
 
8. Overnight interest 
  
Due to international differences in economic conditions, short-term interest rates vary from 

country to country. If the trader sells the currency of a country where interest rates are relatively high 
and buys a currency which earns lower interest, he could be charged interest on his open position. 

The amount of overnight interest is calculated when a position is rolled over. In the Forex spot 
market, all trades must generally be settled within 2 business days. If a trader sells 100,000 GBP on 
Tuesday, he must deliver 100,000 GBP on Thursday, unless the position is rolled over. In essence, 
the position being held is technically closed and exchanged for a new position expiring on the next 
settlement date. The position that is closed and its newly opened substitute are not equal. This 
difference may vary greatly depending on the currency pair and the interest rate differential between 
the two currencies, and fluctuates day to day.  
 

The exact amount of interest charged or credited to an account depends on so-called SWAP 
interest rates, which are normally determined by large institutions using short-term interest rates as a 
benchmark. 
 

On Wednesdays, the amount credited or charged to an account is approximately three times the 
usual amount, because positions opened on Friday are not rolled over until this day, and interest 
accumulates over the weekend. 



www.visualtradingsystems.com 

 

25

9. Reuters News Window 
 

From the Trading Windows menu of the Navigation window, you can select “Reuters News.” 
This displays top market, economic and political news headlines in real time. To view news in detail 
simply click on the headline. The Size entry in the menu allows you to increase or decrease the font 
size of news headlines and stories. Also, notice the clock symbol on the tool bar. When the button is 
not pressed the news constantly changes. A click on this clock symbol freezes the news feed. This is 
a useful feature if, for example, some news items require more detailed consideration.   
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10. Forex News 
 
This window gives the user access to abundant information that may be used for fundamental 

analysis. 
 

 
 

At the top of the news screen, you may choose between live streaming news that updates 
recent price action, a calendar of events, and central bank official rates. Immediately below these are 
Forex market news, top finance stories, and general economic news. 

Click on the headlines to access the full story. 
 
11. Account information 
The Account information panel shows balance, equity, used and unused margin, as well as net 

profit/loss for each of the accounts.  
 
Right-clicking opens a dialogue box that can be used to change this window’s properties (font, 

font color, etc.): 
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12. Order List for Account(s) 
 

This window lists (from left to right) order ID, account ID, order type, first/second currency, 
number of lots, buy or sell, duration, rate, stop/limit orders (if placed), hedge (if any) and time: 

 

 
 
 

13. Summary by Account(s) 
 

The Summary by Account(s) window provides useful information to the trader (from left to right): 
• First Currency 
• Second Currency 
• Number of lots traded 
• Number of unhedged positions 
• Amount in 1,000 currency units 
• Buy or Sell 
• Average open price 
• Closing price 
• Break even point 
• Margin call rate 
• Gross profit/loss measured in pips 
• Gross profit/loss measured in default currency 
• Net profit or loss measured in default currency 
• Commission (if any) 
• Interest 
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14. Reports 
 

 
Visual Trading incorporates a detailed reporting system that displays placed trades in real time. 
To open a report, select “Reports” from the Trading Windows menu on the Navigator window. 
In the first space select your account number, if you have more than one account. The default 

setting is your single account. 
Then choose the period the report will cover. You can set it manually typing in 

month/date/year/time in the “Beginning date” and “Ending date” spaces. Or, you can use a convenient 
feature that automatically selects periods from one day to one year, including week, current month, 
previous month and quarter. 
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15. Account statement 
 

The account statement features order history, settled trades, open orders and open positions: 
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In the upper left corner of the account statement you will find the account number, name and 
address of the account owner, and trader (if these are different persons). The beginning balance 
shows the status of the account at the start of the chosen period for the reports. 

The “Operation History” section of the report lists from top to bottom all transactions (trades to 
open/close positions, rollovers fro existing positions). 

Each transaction is assigned a reference number (fourth column from the left). Other entries 
include (from left to right): 

• Instrument – currency pair traded 
• Lot – number of contracts traded 
• BS – Buy or Sell 
• Open Rate – rate at which the position was opened 
• Close Rate  - rate at which the position was closed 

There are separate columns for transfers, adjustments, credit/debit, gross profit or loss, 
commission/rebate if any, and overnight interest credited or charged. The extreme right column 
shows balance at any time. 

The second section of the account statement lists only settled trades. The columns show (from 
left to right): 

• Number 
• Close Date and Time 
• Ticket Number 
• Instrument, i.e. currency pair traded 
• BS (Buy or Sell) 
• Lot 
• Open Rate 
• Open date 
• Close rate 
• Gross PL, i.e. profit or loss 
• Reason (indicates if the position was closed by the trader, or the stop loss order was 

triggered) 
 
 
The third section provides information on all open orders, including time, order number, type 
(e.g. entry limit), duration, execution, instrument, etc. 
 
The “Open Positions” section of the account statement provides basically the same information 
(ticket number, instrument, number of lots, etc.) for open positions. 
 
In the left lower corner of the screen the following information is provided: 

• Beginning Balance 
• Total Gross Profit/Loss from Settled Trades 
• Commission (zero in our case) 
•  Premium 
• Net Deposit 
• Ending Balance 
• Total Gross Profit/Loss from open positions 
• Equity (i.e. the balance of the account including unrealized profit/loss)  
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16. Trading Hours 
 

Dealing services are offered from 5 p.m. EST Sunday, until 4 p.m. EST Friday with no 
exception for country-specific holidays unless a special notice is given in advance to our customers. 
The market closes at 4 p.m. EST (New York time) on December 31 and reopens at 5 p.m. EST (New 
York time) on January 1. 
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 Definitions of Indicators / Studies 
 

• Aroon Indicator and Oscillator - The Aroon is an indicator system that can be used to 
determine whether the trading instrument is trending or not and how strong the trend is. 
"Aroon" means "Dawn's Early Light" in Sanskrit and the name was chosen for this indicator 
since it is designed to reveal the beginning of a new trend. The Aroon indicator consists of two 
lines, Aroon(up) and Aroon(down). The Aroon Oscillator is a single line that is defined as the 
difference between Aroon(up) and Aroon(down). All three take a single parameter which is the 
number of time periods to use in the calculation. Since Aroon(up) and Aroon(down) both 
oscillate between 0 and +100, the Aroon Oscillator ranges from -100 to +100 with zero serving 
as the crossover line.  

 
The Aroon Oscillator signals an upward trend is underway when it is above zero and a 
downward trend is underway when it falls below zero. The farther away the oscillator is from 
the zero line, the stronger the trend. The age-old problem for many trading systems is their 
inability to determine if a trending or trading range market is at hand. Trend-following indicators 
such as MACD and moving averages, tend to be whipsawed as markets enter a non-trending 
congestion phase. On the other hand, overbought/oversold oscillators (which work well during 
trading range markets) tend to overreact to price pull-backs during trending markets, thereby 
closing a position prematurely. The Aroon indicator attempts to remedy this by helping you 
determine when trend-following or overbought/oversold indicators are likely to succeed. 

 
• Average True Range (ATR) - is a measure of volatility. High ATR values often occur at 

market bottoms following a "panic" sell off. Low Average True Range values are often found 
during extended sideways periods, such as those found at tops and after consolidation 
periods. The Average True Range can be interpreted using the same techniques that are used 
with the other volatility indicators. Refer to the discussion o n Standard Deviation for additional 
information o n volatility interpretation. The True Range indicator is the greatest of the 
following:  

 
• The distance from today's high to today's low. 
• The distance from yesterday's close to today's high. 
• The distance from yesterday's close to today's low.  
The Average True Range is a moving average (typically 14-days) of the True Ranges. 

 
• Bollinger Bands - The basic interpretation of Bollinger Bands is that prices tend to stay 

within the upper- and lower-band. The distinctive characteristic of Bollinger Bands is that the 
spacing between the bands varies based o n the volatility of the prices. During periods of 
extreme price changes (i.e., high volatility), the bands widen to become more forgiving. During 
periods of stagnant pricing (i.e., low volatility), the bands narrow to contain prices. The bands 
are plotted two standard deviations above and below a simple moving average. They indicate 
a "sell" when above the moving average and a "buy" when below it. The bands are used in 
conjunction with other analyses, including RSI, MACD, CCI, and Rate of Change. 

 
• Chaos Alligator - this indicator is based on Bill Williams` recommendations from his book 

"New Trading Dimensions".  The book references chaos theory, and leaves it up to the reader 
to believe whether "supercomputers" were used in formulating the various trading methods. 



www.visualtradingsystems.com 

 

33

Most readers believe that the author's systems to be a perfect filter and trigger for a short term 
trading system. This indicator plots three moving averages based o n the Median 
Price(High+Low/2) for 21, 13 and 8 days, with 8, 5 and 3 days displacement respectively. The 
most popular method of interpreting a moving average is to compare the relationship between 
a moving average of the security's price with the security's price itself (or between several 
moving averages).  

 
• Commodity Channel Index - The Commodity Channel Index (CCI) measures the variation 

of a currency's price from its statistical mean. High values show that prices are unusually high 
compared to average prices whereas low values indicate that prices are unusually low. There 
are two basic methods of interpreting the CCI: looking for divergences and as an 
overbought/oversold indicator. A divergence occurs when the security's prices are making new 
highs while the CCI is failing to surpass its previous highs. This classic divergence is usually 
followed by a correction in the currency's price. The CCI typically oscillates between 100. To 
use the CCI as an overbought/oversold indicator, readings above +100 imply an overbought 
condition (and a pending price correction) while readings below -100 imply an oversold 
condition (and a pending rally).  

 
• Detrended Price Oscillator - The Detrended Price Oscillator (DPO) attempts to eliminate 

the trend in prices. Detrended prices allow you to more easily identify cycles and 
overbought/oversold levels. Long-term cycles are made up of a series of short-term cycles. 
Analyzing these shorter term components of the long-term cycles can be helpful in identifying 
major turning points in the longer term cycle. The DPO helps you remove these longer-term 
cycles from prices. To calculate the DPO, you specify a time period. Cycles longer than this 
time period are removed from prices, leaving the shorter-term cycles.  

 
• Directional Movement Index - The Directional Movement Index helps determine if a 

currency is "trending." The basic Directional Movement system involves comparing the 14-day 
+DI ("Directional Indicator") and the 14-day -DI. This can be done by plotting the two indicators 
o n top of each other or by subtracting the +DI from the -DI.  Analysts suggest buying when the 
+DI rises above the -DI and selling when the +DI falls below the -DI. They qualify these simple 
trading rules with the "extreme point rule." This rule is designed to prevent whipsaws and 
reduce the number of trades. The extreme point rule requires that o n the day that the +DI and 
-DI cross, you note the "extreme point." When the +DI rises above the -DI, the extreme price is 
the high price o n the day the lines cross. When the +DI falls below the -DI, the extreme price 
is the low price on the day the lines cross. The extreme point is then used as a trigger point at 
which you should implement the trade.  

 
• Directional Movement ADX (R) - Measures the strength of a prevailing trend and whether 

or not there is direction in a market. Plotted from zero o n up, usually a reading above 25 can 
be considered directional. ADX defines the tendency and shows, whether it moves quickly 
enough to follow it. ADX helps to take benefit, being still in the middle of important trends. This 
indicator promotes searching of tendency force. If ADX rises, it means that the market 
tendency becomes stronger. At such times, it is desirable to conclude the bargains only in the 
direction of the tendency. When ADX falls, it means that the tendency is questionable. Signals 
submitted by oscillators (RSI, Momentum) are important in this case. The meaning of the 
directional analysis is in the fact that it traces changes in mass optimism and pessimism, 
measuring ability of the bulls and bears to remove the prices beyond the limits of a price range 
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of the previous day. If the today's best price is above yesterday's one, the market becomes 
more optimistic. And o n the contrary, if the today's lowest price is below the yesterday's lowest 
one, it is possible to speak about changing of the market to pessimism.  

 
• Elliot Oscillator - Elliot Oscillator has the following interpretation: The difference between 5 

period MA & 35 period MA plotted as a HISTOGRAM.  In wave 3 the prices are trading in a 
very strong trend, and because of this the 5ma moves away from the slower 35 MA at a fast 
rate & causes the oscillator to have a high peak in ~3.  In ~5 prices are higher, but lacks the 
strong trend as in ~3 & therefore a smaller peak in the oscillator.  Historical tests have shown 
that 94% of time the 5/35 oscillator will pull back to zero during ~4 & therefore identifies ~4.  

 
• Exponential Moving Average (EMA) - The averages are calculated with the recent data 

carrying more weight applying to the overall average. For example: In a 10 day moving 
average, the last 5-10 days will have more value than the first 5 with the idea this will provide 
stronger and earlier trend direction.  An exponential (or exponentially weighted) moving 
average is calculated by applying a percentage of today's closing price to yesterday's moving 
average value. Exponential moving averages place more weight o n recent prices. 

 
• Ichimoku Kinko Huo - Ichimoku was made with the thought in mind that the market price 

movement was determined by time span instead of by the range of prices. That is, in Ichimoku 
the subject of a market price movement is defined by time to the last, and a price is a result.  

 
Definition of each parameter of Ichimoku Chart: 
STANDARD LINE = (High for the last 26 business days + Low for the last 26 business days) / 
2.  The most important idea of the standard line (Std line) is not only where it is plotted in the 
chart, but also where it points. 
 
TURNING LINE = (High for the last 9 business days + Low for the last 9 business days) / 2. 
Turning line shows strength of a trend, coordinated with Std line. Remarkable characteristic is 
to become a support line when a trend forms extensive phase. 
 
SPAN is composed of Leading Upside / Downside. Leading upside is a price continuation of 
mid prices between standard line and turning line shifted forward by 26 business days. Leading 
downside is a price continuation of mid prices between the last 52-days high and low shifted 
forward by 26 business days. Usage for span is expectation from past price fluctuation / trade 
activity, which determines future prices to some extents. 
 
DELAYED LINE emphasized simplification of no calculation but it never can be disregarded. It 
consists of a price continuation of closing prices just shifted backward by 26 business day. 
 
The space between precedence SPAN 1 and precedence SPAN 2 is called clouds (or a 
support belt, a resistance belt).  

 
• Keltner Bands (ATR) - The Keltner Channel is a volatility-based indicator which makes us 

of the "envelope theory" and uses the range of high and low.  Moving average bands and 
channels, like the Keltner Channels, all fall into the general category of envelopes.  Envelopes 
consist of three lines:  a middle line and two outer lines. Envelope theory states that the price 
will most likely fall within the boundaries of the envelope.  If prices drift outside our envelope, 
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this is considering and anomaly and a trading opportunity.  In the case of Keltner Channels, 
when the price touches or moves past either of the outer bands, a reaction toward the opposite 
band can be expected.  When price reaches the upper band, it is believed to be overbought, 
and when price reaches the lower band, it is believed to be oversold.  

 
• MACD (Moving Average Convergence/Divergence) - Consists of two exponential 

moving averages that are plotted against the zero line. The zero line represents the times the 
values of the two moving averages are identical. The MACD is calculated by subtracting a 26-
day moving average of a currency's price from a 12-day moving average of its price. The result 
is an indicator that oscillates above and below zero. When the MACD is above zero, it means 
the 12-day moving average is higher than the 26-day moving average. This is bullish as it 
shows that current expectations (i.e., the 12-day moving average) are more bullish than 
previous expectations (i.e., the 26-day average). This implies a bullish, or upward, shift. When 
the MACD falls below zero, it means that the 12-day moving average is less than the 26-day 
moving average, implying a bearish shift. 

 
• McClellan Oscillator - The McClellan Oscillator is a market breadth indicator that is based o 

n the smoothed difference between the number of advancing and declining issues. Indicators 
that use advancing and declining issues to determine the amount of participation in the 
movement of the stock and currency markets are called "breadth" indicators. Buy signals are 
typically generated when the McClellan Oscillator falls into the oversold area of -70 to -100 and 
then turns up. Sell signals are generated when the oscillator rises into the overbought area of 
+70 to +100 and then turns down. If the oscillator goes beyond these areas (i.e., rises above 
+100 or falls below -100), it is a sign of an extremely overbought or oversold condition. These 
extreme readings are usually a sign of a continuation of the current trend. For example, if the 
oscillator falls to -90 and turns up, a buy signal is generated. However, if the oscillator falls 
below -100, the market will probably trend lower during the next two or three weeks. You 
should postpone buying until the oscillator makes a series of rising bottoms or the market 
regains strength. The McClellan Oscillator is the difference between 10% (approximately 19-
day) and 5% (approximately 39-day) exponential moving averages of advancing minus 
declining issues. 

 
• Momentum - Designed to measure the rate of price change, not the actual price level. 

Consists of the net difference between the current closing price and the oldest closing price 
from a predetermined period. The Momentum indicator can be used as either a trend-following 
oscillator similar to the MACD or as a leading indicator. The interpretation of the Momentum 
indicator is identical to the interpretation of the Price ROC. However, the Price ROC indicator 
displays the rate-of-change as a percentage whereas the Momentum indicator displays the 
rate-of-change as a ratio. As a market peaks, the Momentum indicator will climb sharply and 
then fall off-- diverging from the continued upward or sideways movement of the price. 
Similarly, at a market bottom, Momentum will drop sharply and then begin to climb well ahead 
of prices. Both of these situations result in divergences between the indicator and prices 

 
• Parabolic SAR - The Parabolic SAR (stop-and-reversal) is a time/price trend following 

system used to set trailing price stops. The Parabolic SAR provides excellent exit points. You 
should close long positions when the price falls below the SAR and close short positions when 
the price rises above the SAR. If you are long (i.e., the price is above the SAR), the SAR will 
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move up every day, regardless of the direction the price is moving. The amount the SAR 
moves up depends on the amount that prices move. 

 
• Rate of Change (ROC) - The oldest closing price divided into the most recent one. The 

ROC displays the wave-like motion in an oscillator format by measuring the amount that prices 
have changed over a given time period. As prices increase, the ROC rises; as prices fall, the 
ROC falls. The greater the change in prices, the greater the change in the ROC. The time 
period used to calculate the ROC may range from 1-day (which results in a volatile chart 
showing the daily price change) to 200-days (or longer). The most popular time periods are the 
12- and 25-day ROC for short to intermediate-term trading.  

 
• RSI (Relative Strength Index) - The RSI is a price-following oscillator that ranges between 

0 and 100. A popular method of analyzing the RSI is to look for a divergence in which the 
currency price is making a new high, but the RSI is failing to surpass its previous high. This 
divergence is an indication of an impending reversal. When the RSI then turns down and falls 
below its most recent trough, it is said to have completed a "failure swing." The failure swing is 
considered a confirmation of the impending reversal.  

 
• Schaff Trend Cycle - was developed to improve upon the speed and accuracy of the MACD 

in identifying trends. It is calculated by running a MACD line (the difference between two 
exponential moving averages) through a reworked stochastic algorithm. It is used to find cycles 
within a trend. The peaks and troughs within these "trend cycles" can help identify trends, and 
pinpoint some trading opportunities - buying within uptrends and selling within downtrends. 
This indicator is also useful as the overbought/oversold indicator in sideways markets. This 
indicator cycles or "oscillates" within a fixed scale of 0 to 100. Dotted lines are drawn 
horizontally at 25 and 75, and are called the 25-line and 75-line or "buy" and "sell" lines, 
respectively.  

 
• Simple Moving Average (MA) - The average price of a given time period, (5, 10 min., 

daily, etc.) where each of the chosen periods carries the same weight for the average. 
Example: Day 1 close, USD/JPY 124.00 Day 2 close, 126.00 Day 3 close 125.00. The 4 day 
SMA is 125.00.  Simple moving averages give equal weight to each daily price.  

 
• Stochastic - Stochastic studies are based o n the premise that as prices rise, closing prices 

tend to be near the high value. Conversely, as prices fall, closing prices are near the low for 
the period. The Stochastic Oscillator is displayed as two lines. The main line is called "%K." 
The second line, called "%D," is a moving average of %K. The %K line is usually displayed as 
a solid line and the %D line is usually displayed as a dotted line.  

 
• Stoller Average Range Channels (STARC) - Stoller Starc Bands STARC bands create 

a channel surrounding a simple moving average. The width of the created channel varies with 
a period of the average range; thus the name ('ST' for Stoller, plus 'ARC' for Average Range 
Channel). STARC Bands, in a fashion similar to Bollinger Bands, will tighten in steady markets 
and loosen in volatile markets. However, rather than being based o n closes, the STARC 
Bands are based o n the average true range, thus giving a more in depth picture of the market 
volatility. While the penetration of a Bollinger Band may indicate a continuation of a price 
move, the STARC Bands define upper and lower limits for normal price action. 
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• Volatility - Measures the overall volatility of a given market, time period. Chaikin's Volatility is 
calculated by first calculating an exponential moving average of the difference between the 
daily high and low prices. Chaikin recommends a 10-day moving average.  

 
• Weighted Moving Average (WMA) - A weighted moving average is designed to put more 

weight o n recent data and less weight o n past data. A weighted moving average is calculated 
by multiplying each of the previous day's data by a weight. The weight is based o n the number 
of days in the moving average. In the above example, the weight o n the first day is 1.0 while 
the value o n the most recent day is 5.0. This gives five times more weight to today's price than 
the price five days ago. 

 
• Williams %R - A momentum indicator that measures overbought/oversold levels. The 

interpretation of Williams' %R is very similar to that of the Stochastic Oscillator, except that %R 
is plotted upside-down and the Stochastic Oscillator has internal smoothing. Readings in the 
range of 80 to 100% indicate oversold, while readings in the 0 to 20% range suggest 
overbought.  An interesting phenomenon of the %R indicator is its uncanny ability to anticipate 
a reversal in the underlying security's price. The indicator almost always forms a peak and 
turns down a few days before the security's price peaks and turns down. Likewise, %R usually 
creates a trough and turns up a few days before the security's price turns up.  

 
 
(Some definitions are used from Steven B. Achelis well known book - "Technical analysis from A to 
Z") 
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Part 2: Indicator Builder 
 

Developing Your Own Indicators 
 

1. What is the Indicator Builder? 
Presently, technical analysis is rather complicated, differentiated and constantly developing. New 
concepts and ideas regarding how best to analyze the market from a technical standpoint are 
appearing on a daily basis. We begin to notice that previous technical tools are failing more and more 
often. This is a direct result of that fact that the market is perpetually changing. In order to keep pace 
with these changes we must be very proactive in improving our technical analysis tools. We joyfully, 
and at times greedily, undertake the studying of new theories, absorbing each word, trying to put it 
into practice with the hope to find that “magic" indicator or the approach to trade which will lead to 
greater success in the marketplace.  
 
We spend many hours attentively and scrupulously investigating new literature, thereby improving our 
knowledge in such an attractive and exciting field as spot forex trading. Taking all of this into account, 
the Visual Trading platform allows users to create custom indicators built from the ground up using 
your own formulas through a simple yet very effective process.  
 
Using this new and exciting feature you have the opportunity not only to reproduce any indicator that 
you happen to come across in a specialized magazine or technical analysis book, but successfully 
use it when trading as well. As a result, Visual Trading not only comes equipped with a large number 
of built-in indicators, but is also supplied with a powerful tool called “Indicator Builder” which allows 
you to create these new trading tools. 
 
Indicator Builder is a powerful feature for designing and utilizing your own custom indicators. To be 
able to effectively use it, it is enough to understand the most primitive mathematical concepts and 
logic expressions. If you can write even simple formulas in spreadsheet programs such as Excel then 
you can easily get accustomed with Indicator Builder’s interface and can start developing your 
personal trading tools immediately. 

 
Indicators developed with the help of Indicator Builder are used in 
the same manner as the built-in indicators. They can be called upon 
from the panel VT Navigator - > Trading - > Studies or from the 
contextual menu (the right button of the mouse) directly on the 
diagram/chart.  
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It is possible to develop and save over 1000 
customized indicators on your trading platform. 
Indicators are saved automatically in Visual 
Trading and, therefore, there it is only necessary 
to create and save them one time.  
 
You will be surprised at how simple and 
fascinating it is to create your own trading tools 
with the help of Indicator Builder. Indicator 

Builder is an obedient and reliable assistant capable of satisfying the most sophisticated 
requirements and desires of all traders since it constantly being upgraded with new and sophisticated 
features. Our group of programmers and analysts are continuously improving Indicator Builder as 
they receive various recommendations from experts who are using it. 
 

2. Preparation 
 
Before reading the rest of this manual please make sure that you: 
 
- Are familiar with the manual for Visual Trading System; 
- Have registered and have received an e-mail with login and password information to use in your VT 
software; 
- Have installed and updated DEMO TRADING to the newest available version.  
 
Attention: 
 
In order to avoid the accidental and inadvertent placement of orders, despite the security of system 
from non-authorized actions of the user, all manipulations on creation and testing of indicators can 
only be carried out on DEMO TRADING. 

 
3. Indicator Builder Step by Step 

Step 1 
 
Start Visual Trading System, double-clicking a  
shortcut on the desktop. 
 
 
 
 
 
 
Wait for a pop-up system window and enter your login  
and password. Make sure you  
 
 
 
selected Demo Trading (DEALING DESK - > Demo Trading). Press "Ok ". 
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The indicators designated by 
a badge“ ”, are included 
with Visual Trading. 

You can use keyboard shortcuts and copy text in the editor 
from this document.  
Copying of selected text – CTRL+C  
Moving – CTRL+X  
Insert from the buffer – Shift + Insert or CTRL + V  
The same commands you can use creating the indicator.   

The name that you choose for your 
indicator can be anything you like as long 
as it is easy to remember. 

 
Step 2 
 
Now we are ready to access Indicator Builder.  
 
From the panel of the navigator:  
 
VT Navigator - > Tools - > Indicator Builder  
 
Select Indicator Builder. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
If you see a similar picture on the screen with the list of built-in indicators 
it is ready for further work. 
 
 
Step 3 
 
Press "NEW” button. 
In the "NAME" field please print: Harry Potter 
Indicator 

 
 
 
 

 
 If Visual Trading already has an indicator 

with this name, Indicator Builder will 
automatically add number to the name 
i.e.: Harry Potter Indicator (2) 
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Fields "NAME" and "Short Name" must 
have a value. Otherwise Indicator 
Builder will let you know you made a 
mistake.    

“Short Name” should be unique and should 
include only letters without blanks. Otherwise 
Indicator Builder will let you know you made a 
mistake. 
 

Step 4  
 
In the field labeled “Short Name” print      
“HarryPotter” 

 
 
 
 
 
 
 
 
 

 
 

 
This short name, HarryPotter will identify your 
indicator in the system and will allow you to address 
it and its parameters when using other indicators. 
 
 
 
 
 
 
 

 
Step 5 
 

 
 
 
 
In the column “Label Mask” print: Harry Potter Indicator. 
This is what will be displayed on the Label of the Indicator 
when inserted in the chart. Leave the other columns empty for 
now. 

 
 

    Press “OK”. 
 
 

 
 
 
Step 6 
 
Congratulations, you have just created a brand new Indicator, “Harry Potter Indicator”. Since you 
have not entered any formulas the indicator cannot actually do anything yet. However you can 
already see it in Indicator Builder. 
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Instead of a full names VT can use abbreviations 
as shown below: 
Open – O, Close – C, High – H, Low – L 
A: = (high + low) / 2;   A: = (h + l) / 2; 
These expressions are identical 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Select the indicator and press the “Edit” button. You will see a popup window for editing your 
indicator. This window should already be familiar to you. 
 
 
 
Step 7 
 
 
Select the bookmark labeled “Script/Formula”. 

 
 
 
 
 
 

 
 
 
In the empty window type the given expression:  
A: = (high + low) / 2; 
 
(Semi-colon “;” must be there) 
      
 

 
 
 
 
 
 

Indicators labeled by a badge 

"  " are custom indicators that 
the user has created using 
Indicator Builder. 

Format of expression: “[name of 
variable]: = [expression];” You must 
include the “:” and “;” symbols 
otherwise Indicator Builder will tell 
you that you made a mistake. 
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The following mathematical 
operators can be used in your 
formulas:  
“+” - addition;  
“- “- subtraction; 
“*” - multiplication;  
“/” - division; 
and others such as:  sin(), cos(), sqrt()… 

In this formula the maximal and minimal prices are summed, and then this value is divided by tww. It 
is the formula your indicator will be calculated with. 
 
 
Step 8 
 
Your indicator can already calculate but you need to explain to it what you want it to actually display 
on the charts. Proceed to a bookmark labeled “Output”. 

 
 
 
 
 
 
 
 
 

 
Press “New”.  
 
In the column labeled “Var Name” change the name of the variable from "out" (offered by default) to 
"A" as “A” is what is being calculated by the formula you entered: 
 A: = (high + low) / 2; - “Harry Potter Indicator”. 
Thus you have told Indicator Builder which variable you want to see the value of on the chart. 
 
Proceed to the column labeled "Name" and print: Harry 

This name for the variable “A” will be used later for editing 
the display properties of the Indicator on the chart through 
the “Indicator Properties” window and the “Inspect” 
feature in “Scroll Panel”. 
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Step 9 
 

 
Under the bookmark “Output” you can change default 
parameters: "Line Color ", "Line Width" (it is recommended to 
use value 3), and "Line Type". 
 
The properties of a line adjusted here will now be offered by 
default at the editing properties of any new output variable that 
is created.  
 
 
 
Press “OK” to save this Indicator.   
 

 
Close Indicator Builder, by pressing the “Close” button. 
 
 
Step 10 
 
Right-click on a chart to pull up the menu where you can now select your indicator.  
 
 

 
 
 
 
 
Charts->Add Studies-> 
 -> Harry Potter Indicator 
 
 
 
 
 
 
 

You can edit the default parameters or leave them  
as they are in “Indicator Properties”  
and press “OK” when done. 
 
 
 
Choose the “Select Frame” option and click on 
 “Existent Frame” in order to display the Indicator  
on your current chart. 
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If you have done everything correctly so far, the chart will immediately show your first custom-created 
indicator. It calculates and displays a line with an average value between the maximal and minimal 
value of the price for a given timeframe.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
Step 11 
 
 
Right click on your indicator’s label and select: 
“Edit Studies.” 
After opening the “Studies Editor” window click 
on the bookmark labeled “Script/Formula” and 
change variable "A": 
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A: = high; Press “OK”   
 

 
 
   
 
 
 
 
 

Observe the changes in your Indicator. Now the variable  
"A" is equal to the high value of the price. 
 
Try to change, using the above-stated method (step 11), 
variable "A" to several different values on the bookmark 
 labeled “Script/Formula”. 
 
 
 
 
 
 
 
 
 
 
 Label Indicator -> Edit Studies->Script/Formula 
   A: = Low;   
Press “OK”.  
 
 
 
 
 
 
 
 
 
 
 
Label Indicator -> Edit Studies->Script 

A: = Close; 
            Press “OK”. 
 
 
 
 
 
 
 
 
 
 
 
 
Examine how your indicator changes with different values of “A. 
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Step 12 
 
Pull up the “Studies Editor” and proceed to the bookmark labeled “Input”. 
 
 

Label Indicator -> Edit Studies->Input->New  
 
Enter a name for the new variable.    
 
“Name” ->   B 
 
(Name of a variable for the formula); 
 
“Display Name” -> Price Harry 
 
Select the "Type" column and from the drop-down menu 
choose - > price  
 
 
 

“Default”-> close (what will be offered by default when selecting the indicator); 
 
Click on the bookmark labeled “Script” and 
 edit variable "A" such that: 
 
        A: = B; 
 
 
 
Thus, you have entered into the bookmark labeled 
"Input" a new entrance variable "B" which can  
accept values of the price: Open, High, Low, Close,  
Median Price ((H L)/2), Typical Price ((h L C)/3), and 
according to the formula on the bookmark labeled "Script/Formula" - > (A: = B;) 
its values are transferred to a variable "A" which is displayed  
on the chart (it is specified by you on the bookmark labeled "Output"). 
 

 
B(input)  ->  A:=B;(script)  ->  A(output)-> 
CHARTS 
 
 
 
Access the tool for editing indicator properties: 

 
Label Indicator -> Indicator Setting… 
 
Conduct an experiment with the indicator  
changing its input parameters: 

Price Harry->….. -> OK.  
 
Now “Harry Potter Indicator” can be built  
as a line by the parameters you specified. 
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Expression 
%[name of variable1]%, 
%[name of variable 2]%...... 
In the column  -> Edit Studies -> 
Studies -> Label Mask  

Step 13 
 
We can now begin to customize our newly created indicator even more. 

 
 
 
Label of the Indicator -> Edit Studies -> Studies -> Label 
Mask ->Harry Potter Indicator (%b%)  -> OK 

 
  
 

 
Also check these changes in “Label Indicator”.  
Now you can observe which values are used in  
the parameters of your indicator. 
 
 

Label Indicator -> Indicator Setting-> 
 Price Harry->… -> OK.  

 
 

 
Step 14 

 
 
Do the following: 
 
Label Indicator -> Edit Studies ->Script/Formula ->  
A:= Mov(B,12,E); -> OK 

 
 
A:= Mov {moving Average} 
 (B{Data Array} ,12{period} ,E{method}); 

 
 
 
 
 
Now your indicator can build a  
moving average with a 12 day 
period and exponential by type because  
of our variable "В". When the indicator is  
shown on the chart you can change the  
values parameter "В" can accept: Open,  
High, Low, Close, Median Price ((H L)/2),  
Typical Price ((h L C)/3). 
 
 
 

Moving Average 
Mov (DATA ARRAY, PERIODS, METHOD);

Calculating sliding average for the DATA ARRAY 
with the period of averaging (PERIODS), using a 
method of calculation (METHOD). Available 
methods: EXPONENTIAL, SIMPLE, WEIGHTED, 
(Abbreviated as: E, S, W). If necessary to use a 
Median Price or Typical Price, use functions mp () 
and tp (). 
Use the formula- MOV (CLOSE, 25, EXPONENTIAL) 
Return values of 25-day's exponential sliding
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Now pull up the properties of the indicator for editing: 
 

Label Indicator -> Indicator Setting-> Indicator Properties-> 
 
 
Conduct an experiment with your indicator  
by changing an input parameter: 
 

>Price Harry->... -> OK.  
 
 
 
Notice the changes in “Label Indicator.” 
 
 

 
 
Step 15 

 
Execute the following procedure: 

 
Label Indicator ->Edit Studies ->Studies Editor ->  
Script/Formula -> 
-> A:= Mov (B, Pr, T); {B-Price MA, Pr- Period MA, 
 T - Type MA}-> 

 
Now you have not changed how the formula is calculated, but entered two new input variables: "Pr" - 
will allow changing the period in "Moving Average ", and "T" – will allow changing its type. Do not 
close the editor yet and proceed to the bookmark labeled “Input” and enter values for the following 
parameters: 
 

 
Parameter “Pr”: 

 
-> (Studies Editor) -> Input -> 
-> New -> 
->Name -> Pr-> 
->Type -> integer (with bounds) -> 
->Default -> 12-> 
->Min Bounds -> 1-> 
->Max Bounds -> 34-> 
->Display Name -> Period Harry-> 
 
Do not close the Editor. 
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-> (Studies Editor -> Input) -> 
-> New -> 
->Name -> T-> 
->Type -> MA Type-> 
-> Default -> Exponential-> 
->Display Name -> Type Harry-> 
 
Do not close the Editor. 

 
 
 
On the bookmark labeled “Studies” examine “Label Mask” as shown below to see out of which 
input variables the indicator is constructed: 
 
 ->(Studies Editor) -> Studies -> 
-> Label Mask -> 
-> Harry Potter Indicator (%B%, %Pr%, %T% 
) -> OK 

 
 
 
 

Now your indicator represents a high-grade indicator 
"Moving Average" which is able to show the average 
value from the specified values of the price, period, 
and type of averaging on a chart. 
 
You can observe changes in “Label Indicator” and 
in the properties of the indicator when the window for 
editing is open: 
 

Label Indicator -> 
 ->Indicator Setting-> 
-> Indicator Properties-> 
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Comments in formulas are written in braces {and}.
 A: = ((H L C) / 3); {Typical Price} When used 
properly, comments make it easy to understand 
complex formulas. 

 

 
You may further experiment with the indicator by changing the input parameters: 
 

->Price Harry->…..  
->Period Harry->….. 
->Type Harry->….. 
…..…->OK 

 
Step 16 

 
Pull up the Indicator on the chart and change the calculation formula: 
 

Label Indicator ->Edit Studies ->Studies Editor-> Script/Formula -> 
 
A:= Mov(B,Pr,T); 

{B-Price MA, Pr- Period MA, T - Type MA} 
A2:=Mov (B,Pr2,T); 
{A2-new Out, B-Price MA, Pr- Period MA2,    
 T - Type MA} 

 
Do not close the Editor. 
 

 
 
 
 
 
 

 
 
Now the indicator will calculate two 
formulas for variables "A" and "A2" at once.  
They only differ by their period, "Pr2". To do  
this, it is necessary to enter a variable "Pr2"  
into the bookmark labeled "Input". Next, in the 
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bookmark labeled “Output” input a calculated value of the variable "A2" while under the bookmark 
labeled “Studies” edit "Label Mask" to display in "Label Indicator” the input data. Please do 
everything strictly in this order. 
 

 -> (Studies Editor) -> Input -> 
-> New -> 
->Name -> Pr2-> 
->Type -> integer (with bounds) -> 
->Default -> 26-> 
->Min Bounds -> 3-> 
->Max Bounds -> 144-> 
->Display Name -> Period Potter-> 
->Move Up-> 
 
 
 

 
     -> (Studies Editor -> Input) ->”T”->Display Name-> 

   -> Period Harry Potter->) ->”B”->Display Name-> 
 -> Price Harry Potter-> 

 
 
 
 

Do not close the Editor. 
 

Edit “Label Mask” -> (Studies Editor) -> Studies -> Label Mask-> 
-> Harry Potter Indicator (%B%, 
%Pr%, %Pr2%, %T%)-> 

 
 
 
Do not close the editor. Choose a new variable 
 for “A2” to be shown on a chart: 

-> (Studies Editor) -> Output -> New-> 
->Var. Name -> A2-> 
->Name -> Potter-> 
->Line Color -> Red-> 
->Line Width -> 3-> 
->Line Type -> Line-> OK 
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If, after changes in parameters 
or other adjustments to the 
Indicator, you do not see any 
differences try closing the 
Indicator and reopening it. If 
there are no mistakes, you will 
see the changes. 

 
 

 
 
 
Currently, our indicator pulls up two moving  
averages using variables "А" and "А2" from  
"Close" prices with period 12 and 26 by  
default and type “Exponential”. 
 
 
 

 
Observe changes in “Label Indicator” and its properties when opening a window for editing: 
 

Label Indicator -> 
 ->Indicator Setting-> 
-> Indicator Properties 
 

Continue to experiment with the indicator by  
changing some more of its parameters: 
 
->Price Harry->….. ->Period Harry->….. 
->Period Potter->…. ->Type Harry Potter->OK 
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You can also observe changes using the "Inspect"  
feature of Visual Trading.  
 

Charts -> Scroll Panel-> Inspect…  
 
 
    Label Indicator -> 
->Indicator Setting-> 
->Indicator Properties- > 
->Color/Style->…… 
 

Feel free to familiarize yourself with the indicator by playing around with it and changing some more 
of its parameters: 

 
-> (Color/Style) -> Harry……-> 

->Potter……. -> OK 
 
Step 17 

 
Now access our indicator as before and change its "Short Name." 
 

Label Indicator -> Edit Studies -> 
-> Studies Editor-> Studies -> 
->Short Name-> HP->OK 
 
 
 

 
We can now see the new name using the “Inspect” 
 feature.  
 

Charts -> Scroll Panel-> Inspect…  
 
 
 
 
 
 
Open the editor and specify a name for display in the "Inspect" window. 
 

Label Indicator -> Edit Studies -> 
-> Studies Editor-> Studies -> 
->Inspect Alias-> HAGWARDS->OK 
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A Short Name identifies the Indicator among 
others existing in system. It is unique and allows 
making a reference to its target parameters from 
another indicator. Inspect Alias - serves only to 
display clearly the parameters of the indicator in 
the "Inspect" window. If the column "Inspect" is 
empty, the value of the "Short Name" column is 
shown.

 
Notice the additional changes in the “Inspect” window.  
 

Charts -> Scroll Panel-> Inspect…  
 
 
 
 
 
 
 
 
 
 

Conduct an experiment with the indicator by changing the value of “Short name” in the "Inspect" 
column. Return to the initial position as in step 17. 

 
Step 18 

 
Pull up the “Studies Editor”. Proceed to the “Script/Formula” bookmark and complete the 
operation of changing the way variables "А" and "А2" are calculated. 
 
 

Label of Indicator -> 
-> Edit Studies -> Studies Editor -> -
>Script/Formula -> 
->A:= Mov(B,Pr,T)- Mov(B,Pr2,T); 
A2:=Mov(A,Pr3,T2); -> 

 
Do not close the Editor.  
 
Variable "A"  is the difference between two sliding averages Mov(B,Pr,T) and Mov(B,Pr2,T) of 
periods "Pr" and " Pr 2”.  
 
Variable "A2" is a moving average, Mov(A,Pr3,T2), of the values of variable "A" with the period "PR3" 
and its own type "T2". 
 

Enter variable Pr3 
 
(Studies Editor) -> Input -> New -> 
->Name -> Pr3->->Type ->      
integer (with bounds) -> 
->Default -> 9-> 
->Min Bounds -> 1-> 
->Max Bounds -> 34-> 
->Display Name -> 
-> Period NAGWARDS-> 
 
Do not exit the editor. 
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Enter variable “T2” – type of sliding variable. 
 

-> (Studies Editor) -> Input -> New -> 
->Name -> T2-> 
->Type -> MA Type-> 
->Default -> Exponential-> 
->Display Name -> 
-> Type NAGWARDS-> 
 
Do not exit the Editor.  
 

 
 
 
*** It is necessary to understand that values of the indicator do not coincide with  
values of price movement since the formula used the difference between sliding averages.  
 
Edit “Label Mask”: 
 
-> (Studies Editor) -> Studies -> Label Mask-> 
-> Harry Potter Indicator (%B%, %Pr%, %Pr2%, %T%, %Pr3%, %T2%) ->OK 
 
 
 
Since scales of the indicator and the price do 
not coincide, the indicator has settled down 
on the chart according to the values.  
Remove: 
 

Indicator Label -> 
-> Remove Indicator … 
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and again pull up your indicator on the chart by 
right-clicking: 
 

Charts->Add Studies-> 
 -> Harry Potter Indicator->OK   
Leave the parameters offered by default in the 
dialogue window “Indicator Properties” and 
press “OK”. 
In the “Select Frame” window choose “New 
Frame”: 

 
    
 
 
 

 
 
 
 
 
 

 
->Select Frame->New Frame->OK     
 
The indicator is now displayed in a  
totally separate window. But to  
automate this process it is necessary  
to specify this information in the  
"Studies Editor" window. 
 
 
 
 
Pull up “Studies Editor”. Go on to bookmark 
“Studies”. 

 
Indicator Label -> 
-> Edit Studies ->  
->Studies Editor -> Studies-> 
Placement->New Frame->OK 
 
->Notes-> is for your own notes and/or  
Indicator description. 
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The column “Notes” in “Studies Editor” can be 
used for your own notes if necessary. 

Presence of a tag on “Indicator 
Lock” will protect the Indicator 
from accidental deletion. 

  

Now when you start your indicator it will automatically open in a new frame without another screen 
appearing. Try it: 

 
Indicator Label ->-> Remove Indicator…. 
Charts->Add Studies-> 
 -> Harry Potter Indicator … 
 
 

 
 
 
 
 
 
 
 

 
 

 
Step 19 

 
Pull up “Studies Editor” and click on the bookmark  
labeled “Output”: 

 
 
Label Indicator -> Edit Studies ->  
->Studies Editor -> Output-> 

 
Edit how variables "А" and "А2" will look on the chart: 

 
-> (Studies Editor -> OUTPUT) -> A -> 
->Line Color -> Cyan -> 
->Line Width -> 1-> 
->Line Type -> Histogram-> 
 
Do not exit the Editor. 

 
 
-> (Studies Editor -> OUTPUT) -> 
->A2 -> 
->Line Color -> Red  
->Line Width -> 1 
->Line Type -> Line-> 

 
Press “OK”. 
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Observe how the indicator changes now. 
 

 
 
 
 
       

 
 
 
 
 
 
 
 
Now these adjustments will be offered by default when indicator is brought to the chart. You can 
always change them. Bring up the “MACD-Line” indicator that came with Indicator Builder and 
compare it with your “Harry Potter” indicator. They should be identical.  
 
 
If you see a similar picture on your own screen  
then you did everything correctly and you have  
a good understanding of the basic principles at  
work in Indicator Builder. In future chapters  
added to this manual the detailed description of  
the functional value of each element in the various indicators will be included. Indicator Builder is 
simple and reliable, created specially for forex  
traders of all types, capable of transforming  
laborious tasks into pleasure. It offers a  
comfortable user interface and can easily adapt  
for your needs.   
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From the panel of the navigator select Indicator Builder and find the indicator that you created:  
 
 
 
 
 
 
 
 
 
 
VT Navigator -> Tools -> ->Indicator Builder->>Edit Studies->… -> Name Indicator-> Export-> 
   
 
 
Press the “Export” button. 
 
Specify the name of a file and the location  
where you want it stored. 
 
->File Name-> 
->Harry Potter Indicator-> 
->Save->Close … 
 
 
You can also share your saved file with  
others; keep it with your other indicators,  
edit, rename, and delete if needed. 
 
 
Step 20 
 
Find the newly exported indicator and execute various operations using it.   
 
- To import it to a system through Indicator Builder use the “Import” feature. 
 
  VT Navigator -> Tools -> 
   ->Indicator Builder-> 

  >Edit Studies->Import-> 
->Harry Potter Indicator-> 
->Open …. 

 
- Pull up it for editing and enter a password.  

 
(->Indicator Builder->->Edit Studies->)-> 
->Harry Potter Indicator (2) ->Edit-> 
->Studies Editor->Studies-> 
->Password->123456 
->Confirm Password->123456->OK-> 
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->Edit->Visual Trading-> 
->Password->123456->OK-> 
- To remove the imported indicator you first  
need to make sure that the “Indicator Lock”  
option is unchecked and then: 
 
 
 
 

->Studies Editor-> 
->Indicator Lock->Off->OK-> 

   
 

-> (Edit Studies) -> 
->Harry Potter Indicator (2) 
 ->Delete-> 
->Request for Confirmation-> 
 ->OK 
 

 
 
 
Step 21 (Final) 
 
Now try doing everything yourself. 
 
First clear the diagram so that it is free of any indicators. Open your "Harry Potter Indicator" on the 
chart and in a separate frame open the "MACD" indicator that came with the system. 

 
 
 
Compare the two indicators. Try to change 
"Harry Potter Indicator", using the tools and 
ideas discussed in this manual, until it looks 
like the MACD indicator.  
 
 
 
 
 

 
 

 
 
 

Hopefully this has given you a basic understanding of the things Indicator Builder is capable of and 
we wish you luck in using this wonderful tool. 
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Part 3: Trading System Builder 

 
1. General Concept of Trading System Builder and its implementation 

in the Visual Trading System 
 
 

 Looking further into the building of proprietary indicators and oscillators, many traders have a need to 
combine them into certain strategies or systems and use them as recommendations for trading. These 
recommendations should be based on the analysis and signals generated by the indicators and oscillators.  
 

Many traders would like to create proprietary trading systems that provide easily understandable 
signals for action, in accordance with clearly defined and previously confirmed logical formulas, free of 
emotional influences and poor decisions. This problem is familiar to anyone with even modest trading 
experience in the financial markets. The demand for the creation of trading strategies grows every day 
worldwide. 

  
The developers of the sophisticated Visual Trading system offer users such a possibility. One of the 

most remarkable aspects is that, on the Visual Trading platform, your Trading System could not only provide 
recommendations in accordance with your proprietary logical formula, but could be set to place trades 
automatically. This means that you need only observe and manage the process from time to time. 

 
Initially, the developers were faced with the question of what exactly the trading system should be 

capable of doing, not in the sense of being able to make right or wrong decisions based on the user’s formulas, 
but in the sense that such a trading system should fully meet the requirements of the trader. First, it is 
necessary to be able to create a system that would make certain decisions in accordance with certain 
formulas. A balanced Trading System includes elements such as signs reflecting a given state of the market 
and well calculated points for the most profitable entry and exit from the market. And this should all be 
exclusively in accordance with the user’s needs and his/her formula.  

 
That is why the unique Trading Systems Builder (TSB) was designed to meet even the most demanding 

requirements involved in developing such systems and their uses.   
 
The basic concept of TSB is the following: 
 
The Required Situation and the Point of Necessary Action appear in the market only if a certain 

condition is met. A given condition can always be described with the language built into Visual Trading. If this 
condition becomes true or false at a certain time, then the action associated with given condition may be taken 
and the Situation itself reflected. 

 
 
 
 
  
 
 
 
 

Condition Action 
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Therefore, the main task of the user is to determine and describe the necessary condition (or a 
combination of conditions required to take action) and assign certain actions to it. The condition itself will be 
described with the help of the language built into Visual Trading (see related document), and may be either 
true or false. Depending on the state of the condition, the associated action is either taken or not taken. 

 
 

What exactly is meant by action? Therein lays the main issue in developing a trading system (TS). The 
actions of the TS must generate signals on the chart, depending on the state of the market, that are based on 
the user’s requirements and must designate and report optimum calculated points for taking action. The user 
can either manually accept the suggested action using TS signals as recommendations, or switch the Trading 
System into automated trading mode, resulting in the system itself placing trades based on the formula created 
by the user.  

 
Currently all actions may be categorized as being one of the following types: 
 
 1.   Visual reflection  
  
The required signals in accordance with the user’s formula are immediately reflected on the price chart. 

In this type, colored markings or special symbols can be used. It is also possible for an entire region on the 
chart to be marked. As a general rule, this category of reflection is used as a recommendation-type action or in 
conjunction with other types of actions.               

 
2.   Visual and sound alerts 

 
In this case the Trading System, in accordance with the user’s specification, can alert the user to a 

particular trading situation, either visually by flashing a message on the screen and/or via a sound alert.  
 
 3. Error message 
 
An error message warns about improperly entered parameters into the Trading System that are 

inconsistent with the formula of calculations and may result in wrong actions in decision-making. Such an 
action provides a message and sound alert, but also suspends the operation of the Trading System, requesting 
the user to change the entered parameters.  

Action Taken 

Action  

Сondition 

False  True 

No Action Taken 
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Action Action 

Condition Condition 

Trading System

Type   Type Type Type 

 4. Action involving real trading operations 
 
This type of action is perhaps the most important and even crucial. After prescribing the formula for 

operations, the user might want to view how the Trading System, based on his/her personal formula, buys or 
sells at appropriate points. It is highly recommended that you control this process from time to time and make 
sure the trading platform is securely connected to the data server. This type of action is designated only for the 
Auto trading mode and may be switched off at any time.  

 
Clearly, the first three types of actions serve the purpose of reflecting, one way or another, the signals 

as recommendations. Only the last type is used in the real Auto trading mode. All actions may work separately 
from each other or together and, moreover, different actions may be described by one and the same condition. 
In other words, one condition might be assigned several actions.  

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
This concept of the Trading System Builder opens up the possibility of a flexible approach to creating 

and taking full advantage of the Trading Systems on the Visual Trading platform. Before implementing the 
desired system and building it into the platform, it is recommended that the user read the list of books 
describing the principles of creating such systems and, only after that, utilize the resources of Visual Trading. 
We assume that the user is fully aware of the formulae for the desired actions required from the 
Trading System, and the Visual Trading platform will only assist in this endeavor. 

 

2. What is the Trading System Builder? 
 

The Trading System Builder is a powerful instrument for creating Trading Systems. However, in order 
to use it effectively one must understand the principles of building such systems, and how they must be 
implemented within the platform that has been chosen for that purpose. If you are at least somewhat familiar 
with writing formulas for spreadsheet table programs and have tried to create proprietary indicators or 
oscillators on the Visual Trading platform with the help of Indicator Builder, you should experience no difficulty 
in mastering formulas and can start developing your own trading systems immediately.  
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The Systems that you create are automatically saved in Visual Trading, so there is no need to re-enter 
them each time you wish to employ them.  

 
The platform is structured in such a way as to provide maximum convenience to anyone using and 

managing trading systems, and consists of a combination of three components, each responsible for its own 
sector of activities. Even the simplest system must first be created, and then stored somewhere, copied, 
moved and exported if necessary. Secondly, it is necessary to write down and edit the trading system itself. 
And, thirdly, you must be able to start the trading system, attach it to the trading chart and manage the system 
in a real environment. 

  
In order to clearly understand the structure and the principles of developing systems on the VT Trader 

platform, users should study this manual step-by-step and, in the course of such study, necessary explanations 
will be provided. And we hope that our efforts will result in your understanding how to move from the 
development of the concept of the Trading System to its practical functionality.  

 
3.  Trading System Builder: Step-by-Step approach 

 
Setting the Tasks. Preparation for Work 

 
 

Before we start our work it is necessary to define how and according to what formula the system under 
development should function. However, since this manual is aimed at teaching the user not only the principles 
of creating the right systems, but empowering him/her with the ability to put his/her designs into practice, let us 
take a simple, logical and easily understandable formula as an example.  

 
While reading certain books you have probably come across different systems proposed by different 

authors. Let us take as an example a rather simple Trading System and make it function on the VT Trader 
platform, using the recommendations of its author.  

 
Below, you will see parts of a letter from the author of such a system taken from an internet website. In 

the letter the author proposes using an RSI oscillator smoothed by moving averages with different parameters 
(in particular, exponential 10 and 30 day period MAs). First, read this letter and create the proposed system on 
our platform:  

…………………………………… 

Anybody tried using TC2000's new moving average based on relative strength in Metastock? 

I developed a good indicator to identify trends in stocks, but TC2000's idea of using a 10 and 30 day 
moving average of relative strength (vs. SP500, NASDAQ,   etc.), works as well or better than mine. Using 
moving averages based on the stocks' relative strength to a broader market average eliminates market 
gyrations from the equation and allows the moving averages to be sensitive only to 
stock performance relative to the index. 

  I programmed this into Metastock by plotting a relative strength indicator in white (making it invisible 
on white background),   and created 2 moving averages based on this indicator (10 and 30 exponential).   
When the 10-day crosses above the 30 day, this is assumed to be bullish, and   you look to be bearish when it 
crosses back below the 30-day line.  Obviously,   the two moving averages can be any number, but these 
seem to work well. 
 

I tested this setup on many NASDAQ stocks by   programming an expert with my indicators (not 
TC2000) and comparing the trend changes to mine visually, and saw that they were very similar. My system is 
very accurate for finding trends, and entry points, so I'm assuming this TC2000 setup is as reliable.  I haven't 
found a way yet to program relative strength into a system test, so if anybody knows how I'd appreciate 
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learning the secret.  I used the SP-500 as the comparison to NASDAQ stocks because it correlates well with 
the NASDAQ, but isn't as volatile. 
 

My trading system only uses the trend as one   piece and several other indicators for entry and exit, but 
I believe this indicator is as close to perfect for determining trends as you'll find. 
 

Dave D. 
 

………………………………….. 
 
 So, the letter’s author, let’s call him Dave, proposes to plot 10 and 30 day moving averages (MoV) 
based on the Relative Strength Index (RSI) and use their crossovers as signals to enter the market. If the 
faster 10 day MoV crosses above the slower 30 day MoV, all short positions, if any, are closed and long 
positions opened. And if the crossover occurs below, all long positions are closed and short positions opened.  

 
Savvy traders with many years of experience watch the RSI indicator closely. And now we will see what 

happens if the user follows the approach, proposed by Dave.  
 
Note: 
To avoid accidental opening of positions on real accounts, we strongly advise you to conduct all 

activities and testing of Trading Systems on demo accounts. 
 
After we have outlined the task, please start the trading platform in demo mode, select and open a new 

chart. To avoid any confusion, open a one hour EUR/USD chart and erase all indicators and oscillators from it.  
 
Everything is ready for work. 
 

Step 1. Creation of an Indicator to Evaluate its Possible Use in a Trading 
Strategy 
 

As a first step we’ll create the proposed indicator in the VT Trader system and observe how it works, 
using prices from the chart. If you’ve already had experience creating indicators, this should not be 
complicated. Still, for the purpose of demonstration, we’ll examine the steps required in detail.  

 
 
 
 
 

From the Main menu select Indicator Builder, using the following path: 
 

  
 
 

VT Navigator -> Tools -> Indicator Builder -> 
->Indicator Builder … 
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 On the left side of the Indicator Builder pop-up window, you will find the “Relative Strength Index.” 
Select it by clicking on it. Because our new indicator is based on RSI, we need not create it from scratch, rather 
we will simply edit the existing one and give it as new name. To do this, after clicking on “Relative Strength 
Index,” click the “Clone” button.  
 

 
 

 
 
 
 

Indicator Builder -> 
-> Relative Strength Index->Clone->… 

 
 
 
…->Studies Editor 
 
 
 
 
 
 

 
 
 

 
 In the “Studies Editor” pop-up window, moving 

from one folder to another, make the following changes: 
  
 
 
 

 
In the “Studies” folder, next to “Name,” change the indicator name from Relative Strength Index (2) to Moving 
Average of Relative Strength Index. 

 
 

…->Studies Editor -> Studies-> Name -> 
Relative Strength Index(2) -> Moving Average of 

Relative Strength Index 
 

 
The “Short Name” must be changed from what is there. If this is not done, then in the case that this 

short name already exists in the VT Trader system, and that is precisely the case, when saving the new 
indicator, the system will issue a warning. The short name is the name you will use when pulling up this 
indicator and its parameters. Change the short name to MARSIndex. 

 
 
 

…->Short Name -> RSIndex -> MARSIndex 
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Next to “Label Mask,” change Relative Strength Index (%tpr%) to MA Relative Strength Index 
(%tpr%, %MA1pr%,%MA2pr%), where the %MA1pr% and %MA2pr% functions will display on the indicator 
label the value of periods used in plotting the RSI moving average. In our case, these values are 10 and 30, 
but we will initially allow for the possibility of entering different values when our indicator is plotted on the chart 
for use in a specified situation.  

 
…->Label Mask -> Relative Strength Index (%tpr%) -> 

 MA Relative Strength Index (%tpr%, %MA1pr%, %MA2pr%) 
 
 

 
Next to “Inspect Alias,” change RSI to MA RSI. 

 
…->Inspect Alias -> RSI -> MA RSI 
 

 
The next step is to select and delete the definition of the RSI indicator in the “Notes” section, by right-

clicking and selecting Select All, then right-clicking again and selecting Delete. 
 

      
 
This space is used simply as a description of the indicator you are editing, so you can type in whatever 

you wish or copy and paste anything. It will not be used anywhere else.  
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Next, click on the “Input” tab on top. 
 

 
 
…->Studies Editor ->Input -> 
 
 

 
Following each of the two paths below, enter parameters MA1pr and MA2pr to be used in the 

calculation of the indicator formula:  
 
…-> New -> Name -> no name ->MA1pr -> Display Name -> Period MA1->Default ->10  
…-> New -> Name -> no name ->MA2pr -> Display Name -> Period MA2->Default ->30  
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
***Note: 

If you accidentally close the indicator editor by clicking the “OK” button, you can find it in the list of the 
“Indicator Builder” window as the indicator named “Moving Average of Relative Strength Index” that you 
created. Select it using the cursor, and click the “Edit” button to return to editing. But in case you’ve closed the 
editor by clicking the “Cancel” button, then the changes you made will not be saved and you’ll have to start 
from the beginning and repeat all of the previous steps. Therefore, it is recommended that, from time to time, 
you save changes to the indicator that you develop, as soon as you give it a name, to prevent this situation.  

 
What we have now is not just the name of the indicator and its basic options selected, but also the 

variables to be entered for the purpose of calculating the indicator’s formula.  
 
Next, click on the “Formula” tab. Here, the formula for calculating the Relative Strength Index is 

presented. 
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Copy the entire text of the formula from this section or edit the formula as specified below 
(commentaries are presented in brackets): 

 
{ Relative Strength Index} 
 
 rsi_r:= (CLOSE - ref(CLOSE,-1));  
 rsi_rs := Wilders(if(rsi_r>0,rsi_r,0),tpr) / Wilders(if(rsi_r<0,Abs(rsi_r),0),tpr);  
RS:= 100-(100/(1+rsi_rs)); 
 
{ Moving Average of Relative Strength Index} 
 
MA1:=MOV(RS,MA1pr,E); 
MA2:=MOV(RS,MA2pr,E); 
 
While editing the indicator code, we introduced new variables MA1 and MA2 that are calculated in 

accordance with the formula, specified in the script.  
 
For example, MA1:=MOV(RS,MA1pr,E) means: calculate exponential (E) moving average (MA) from 

relative strength (RS) with a period of MA1pr (the abbreviation from Moving Average 1 PeRiod). RS is the final 
calculated value of the Relative Strength Index indicator, and the value of MA1pr was specified as the 
parameter to be entered in the “Input” bookmark and equals 10 for MA1 by default. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Next, click on the “Output” tab and set 

variables MA1 and MA2 to be plotted on the 
chart.  

 
 
 
 
 
 

  Studies Editor ->OUTPUT -> 
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Conduct the appropriate operations by following the paths. 
 

 
We will change the default way of plotting the RS 

parameter on the chart: 
 
 
OUTPUT ->… 
… RS-> Line Type -> Faltering ->… 
 
 
 
 
 

 
Introduce MA1 variable into the chart field and specify the default properties: 

 
 
 
 
 
…-> New ->Var Name-> 
 -> Out -> MA1 -> Name -> 
 ->MA1 -> Line Color -> 
-> Red-> Line Width -> 2 

 
 
 
 
 
 
 
 

 
Bring MA2 variable into the chart field and specify properties set by default: 
 

 
 
 
 
 

 
…-> New ->Var Name-> 
-> Out -> MA2 -> Name -> 
->MA2 -> Line Color -> 
-> Dark blue-> Line Width ->2 
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The creation of the Moving Average of Relative Strength Index indicator in the VT Trader system is 

completed. Click “OK”, and if everything was done correctly, you will see the new indicator in the “Indicator 
Builder” window. 

 
 
 
 
 
 
 
 

 
Close this window by clicking the “Close” button. On the chart field, right-click to bring up the context 

menu. From “Add Studies,” select “Moving Average of Relative Strength Index” and bring it to the chart field: 
 
 
 

…-> Add Studies-> 
->Moving Average of Relative Strength 

Index 
 
 
 

 
You will see the parameters of the indicator. You specified those parameters under the “Input” tab while 

creating the indicator.  Click “OK”. 
 
 
 
 
-> OK. 
 
 
 
 
 
 
 

 
Plot the indicator on the chart. Pay 

attention to the label. Here, parameters are 
reflected that were specified in the process of 
bringing the indicator into the price chart. 

 
Carefully evaluate this indicator, 

especially the red/blue line crossovers, as they 
relate to the price movement. 
According to Dave, the author of the original 
letter, long positions should be taken when the 
red line crosses over the blue one and short 
positions should be taken when the red line 
crosses under the blue line.  
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 Judging from experience, one should understand that any indicator or oscillator provides a more 
precise reading if applied to large scale price movements, because on a smaller scale price movement is 
subject to a greater number of fluctuations and indicator parameters have to be adjusted. When we created 
this indicator we left open such a possibility. The author maintained that the trading system was applied to a 
one day chart. However, we were satisfied with the indicator’s reading even on a 2-hour interval chart, but on a 
smaller scale the parameters of this indicator will have to be changed, filtering out the “market noise.” 
  
 Currency pairs and chart scales should be changed. Check the efficiency of such an approach on 
different time intervals. Remember that the purpose of this manual is to teach you how to construct proprietary 
trading strategies on the VT Trader platform. So we will leave the parameters unchanged, proposed by the 
indicator’s author, and create a trading strategy based on its signals and make it work without our involvement.   
  

Step 2. “Edit Trading Systems” Component 
 

In this section, we will learn how to use the “Edit Trading Systems” component. You will begin to 
develop your first trading strategy based on the indicator that was created. 

 
This “Edit Trading Systems” component is responsible for storing trading strategies, moving and 

bringing them up for editing. All of this allows the user to create his/her own trading strategies database, so 
that these strategies are readily available for use at any time.   

 
 
Therefore, strategies developed with the Trading System 

Builder can be edited, moved, deleted or exported/imported at any 
time through the Trading Strategies Editor that can be brought up 
from the VT Navigator window.  
 
 

VT Navigator -> Tools -> Trading Systems -> 
->Edit Trading Systems… 

 
Bring up the editor from the Navigator panel.  

 
 
 

 
 

The “Edit Trading Systems” window helps  
to manage the structure of the Trading Strategies 
represented. 

 
 On the left side we see a set of trading systems 
 created by the user or supplied together with VT Trader, 
 and on the right side of the same window are the  
 controlling buttons. 
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- The “NEW” button allows the user to begin developing a unique new system. When pressed, 
this button brings up a special window called “Studies Editor” that is used for the purpose of 

editing trading systems. 
 

 
 
 
 
 

 
 
- The “EDIT” button brings up a special window called “Studies Editor” that is used for editing 
the Trading System that was selected with the cursor when the “EDIT” button was clicked. 

 
 
- The “CLONE” button allows the user to copy the system selected with the cursor and brings 
up a special window called “Studies Editor” for editing the Trading System that was copied.  

 
 

- The “DELETE” button removes the system that was selected if protection against deletion 
was removed in the options menu. This issue will be dealt with in more detail below. By 

default, all Trading Systems are protected against accidental deletion, and the “DELETE” button will be 
highlighted only if the user manually removes protection in system properties by bringing up a special window 
called “Studies Editor” by clicking the “EDIT” button. 
 

 
- The “EXPORT” and “IMPORT” buttons are used respectively for exporting and importing 
built-in, as well as newly created, systems. This ensures flexibility when exchanging trading 
systems or storing them separately. 
 
 
- The “CLOSE” button closes the window.  
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Do not close the Trading Strategies editor. Click the “New” button to create a new strategy and bring up the 
Studies Editor component.  
 

Edit Trading Systems -> NEW -> Studies Editor… 
 

 
 
 
 

Step 3. “Studies Editor” Component and Development of Trading Strategy 
 
 
 This component allows the user to develop and directly edit the Trading System. It is brought up from 
the “Edit Trading Systems” component by clicking the “New,” ”Edit” or ”Clone” button depending on the user’s 
intention: 
 

VT Navigator -> Tools -> 
Trading Systems ->Edit Trading System-> NEW… (EDIT, CLONE) 

 
 
 
  
 
 

 
 The component consists of four tabs. Since you now know how to create indicators, many things here 
will be familiar to you. Each of the tabs has its own function, but all of them belong only to the properties of the 
Trading Strategy that is created or edited. 
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  The “Studies” tab  
This specifies the general properties of the strategy that is 

developed by the user. 
  

 
   

Fill in the “Name” with the system’s unique name that will be later reflected in the left part 
of the “Edit Trading Systems” component. 

 
  Name -> Moving Average of Relative Strength System 

 
 
 

 
The “Short Name” is necessary to identify the trading system within the entire VT Trader 
platform. At this stage there is no short name being used, but we will fill in “MARSS” 

(abbreviated from Moving Average of Relative Strength System). The name is entered without spaces and 
punctuation marks, just using letters and numbers. 
 

Short Name -> MARSS 

     Click the “OK” button.       
 

Make sure you can see the strategy name in the “Edit Trading System” window. 
 
 
 
 
 
 
 

 Select the trading strategy name with the cursor and bring it up for editing by clicking the “Edit” button: 
 

Edit Trading System-> EDIT-> Studies Editor 
 

Continue editing the Trading Strategy. 
 

 
“Label Mask” is used to specify variables separated by the % sign in order to take into 
account the values of these variables when the strategy’s formula is calculated. For 

now, leave this space blank. We will return to this issue when the system is ready.  
 

 “Real-Time” specifies the frequency of the re-calculation of the 
trading strategy’s results. 
 

When “Each Tick” is selected, the system will use each 
new incoming price value for the purpose of calculations. When “Complete Bar” option is chosen, the system 
will make decisions and provide results only after the price bar of the interval used by the Trading Strategy is 
completely formed. For now, select the “Each Tick” option. 

 
Real-Time-> Each Tick 
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The checked box next to the “Indicator Lock” option protects against accidental deletion of 
your trading strategy from the VT Trader system. If the box is unchecked, the “Delete” button 

on the “Edit Trading Systems” component is activated and the trading strategy can be deleted.  
 

Indicator Lock -> On 
 

The “Notes” field is used to describe a given strategy. The entered data is not 
reflected anywhere in the system and is not used for anything else. You can type 
in anything you like or leave this field empty. 
 

 
You have the option of setting a password for your trading strategy. To 
set a password, enter it into the “Password” and “Confirm Password” 
spaces. Keep in mind that passwords are case sensitive. The next time 
you bring up your trading strategy for editing, the VT Trader system will 

require you to enter the password that you selected. Thus, you will be able to hide the principles and formulas 
of your strategy. The password protection feature remains in place when importing or exporting the trading 
strategy. For now, leave the password option blank. 
 

In order to designate the names and types of variables that would be entered for the purpose of 
calculating the strategy’s formula and categories of its actions, click on the “Formula” tab. 

 
The “Formula” tab 

 
The main purpose of the “Formula” tab is to allow the 
user to describe the logical and mathematical formulas 
that will form the base for taking the desired actions: 
  

Studies Editor->Formula 
 

  The strategy that is being developed is based on the Moving Average of Relative Strength Index 
indicator that you’ve just created and refers to the position of the two RSI moving averages next to each other: 
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According to the author’s recommendation, whenever MA1 crossover occurs above MA2 (that is 
precisely the required condition) it is necessary to assume long positions, and when the crossover occurs 
below (again, the necessary condition) a short position should be taken. 

 
It is necessary to “explain” this to your trading strategy. It should be understood that although the VT 

Trader system understands only the language of mathematics and logic, it will do exactly what you will tell it to 
do. To write the strategy’s script we recommend using any standard Windows word processor (for example 
Notepad). Then use the “Copy” function to insert what you wrote into the “Formula” field. Be generous when 
writing commentaries inside the brackets. 

 
The value of RSI is used directly in the calculations. Copy and paste it into the formula of calculations in 

Notepad or straight into the “Formula” field. It is directly involved in the calculations: 
 
 { Relative Strength Index} 
 
 RSI_r:= (CLOSE - ref(CLOSE,-1));  
 RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),14) / Wilders(if(rsi_r<0,Abs(rsi_r),0),14);  
 RS:= 100-(100/(1+rsi_rs)); 

 
It is not necessary for you to understand this formula at this stage. Accept it as it is. Just copy and paste 

it. (If you are interested in knowing exactly how this oscillator works, we recommend that you read books on 
this subject.) Rather than rewriting the formula, we could instead have referred directly to it using its 
identification number, which can be seen if you bring any indicator in the “Short Name” column for editing. But, 
to avoid confusion and facilitate finding mistakes, it is recommended that when creating the system you rewrite 
all elements involving calculation. We intentionally made the RSI period equal to 14, and we will later introduce 
changes into this approach, so that the parameter could be specified whenever the system is used. 
  

The calculations make use of the RSI moving averages, and this too must be indicated in the Strategy’s 
script. Copy and paste the text below:  
 
  {Moving Average of Relative Strength Index} 
 

MA1:=MOV (RS, 10, E); 
MA2:=MOV (RS, 30, E); 

 
  By now you have specified all preliminary elements required for action.   
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The Strategy already “knows” what to calculate, but has no idea what to do with the results. In order to 
make it undertake some actions, it is necessary to define a certain variable, set a condition for it, and if this 
condition turns out to be true, have the strategy implement the designated action. 

 
 All of the variables mentioned above are not logical by nature. A logical variable can only assume one 

of two values, such as “true” or “false”, zero or 1. At any time it can have only one stable state. 
  
 Per the strategy, we will let the system give out a signal when it is required to open a long or short 
position. Because we make an estimate of the fact that the MA1 and MA2 crossover occurred and are not 
interested in knowing what has greater or lesser value, it makes sense to use the built-in function of the Visual 
Trading CROSS language: 
 

SYNTAX cross (DATA ARRAY 1, DATA ARRAY 2) 
FUNCTION Plots a "+1" on the day that DATA ARRAY 1 crosses above DATA ARRAY 2.  Otherwise, 

"0" is plotted. 
If you want to know when DATA ARRAY 1 crosses below DATA ARRAY 2, use the 
formula "cross (DATA ARRAY 2, DATA ARRAY 1)" 

EXAMPLE cross (close, mov (close, 9, e)) 
 

We’ll use this as a foundation to create two variables such as LONG and SHORT.  Copy and paste the 
text below into the strategy’s script:  

 
{Signal Long and Short} 
 
Long:= CROSS (MA1, MA2); 
Short:= CROSS (MA2, MA1); 

 
It is worthwhile to note the advantage of the CROSS function, which dictates that it always equals zero, 

except in the case of crossover of the two values, which will generate a 1.  
 
We used the expression: Long:= CROSS (MA1, MA2). This orders the system to compare MA1 and 

MA2 values with one another at all times, while assigning the Long variable the value equal to 1 only at points 
when MA1 becomes greater than MA2; the rest of the time let the Long variable be equal to 0. 

 
We used the expression: Short:= CROSS (MA2, MA1). This orders the system to compare MA1 and 

MA2 values with one another at all times, while assigning the Short variable the value equal to 1 only at points 
when MA1 becomes less than MA2; the rest of the time let the Short variable be equal to 0. 

 
The entire script can be seen by now in the “Formula” field: 
 
{Relative Strength Index} 
 
 RSI_r:= (CLOSE - ref(CLOSE,-1));  
 RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),14) / Wilders(if(rsi_r<0,Abs(rsi_r),0),14);  
 RS:= 100-(100/ (1+rsi_rs)); 
 
 {Moving Average of Relative Strength Index} 
 
 MA1:=MOV (RS, 10, E); 
 MA2:=MOV (RS, 30, E); 
 
 {Signal Long and Short} 
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 Long:= CROSS (MA1, MA2); 
 Short:= CROSS (MA2, MA1); 
 
 We now must specify the type of action to be associated with the Long and Short variables. To 

do this, click on the “Output” tab. 
 

 
Studies Editor-> Output… 

 
 
 

The “Output” tab 
The “Output” tab allows us to indicate precisely to which variables from the strategy’s formula the 

system should react, and precisely what actions it should take if the conditions of this variable are true. 
 
 Follow the path below, and we’ll then comment on them: 
 

Studies Editor-> Output… 
…->New->Output Variable Properties… 

 
The “Output Variable Properties” window serves 

the purpose of specifying the action for the variable and 
directly managing its’ parameters. 
 
 

Next to “Var Name,” indicate the name of the variable to which the system should react: 
 

…->Output Variable Properties->Var Name->LONG 
 
 Try to be precise and indicate properly the names of the variables 
from the formula. The system is indifferent to what you write, but if it 

does not find such a variable it will assume that it is equal to zero and will not take any action. This entry is not 
case-sensitive.  
 As a rule, to facilitate the entry of the formula, text abbreviations are used instead of the full names of 
variables. Next to “Name,” write down a phrase that is easy to understand: 

 
…->Output Variable Properties-> Name->Signal LONG 
 

The description of this variable may be entered in the “Description” field.  This field can be left empty. 
 

 
…->Output Variable Properties-> Description -> 

-> Long:= CROSS (MA1, MA2); 
 

The type of action assigned to the variable will be selected by checking the box opposite each available 
option. 

 
The “Graphic Enabled” option brings up a graphic object or sign to the price chart if the 
logic variable is true. The sign’s properties and parameters depicted on the chart are also 

specified under the “Graphic” tab.  
 

 
…->Output Variable Properties-> Graphic … 
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The “Graphic Enabled” option lets the user choose the desired color for the chart bar 
under the “Highlights” tab, provided the variable is true. 

 
 

…->Output Variable Properties-> Highlights 
 

 
 

 
The “Alerts Enabled” option will turn on a sound alarm and/or bring up a message to the 
screen, depending on the condition of the variable. The alert parameters and the text of the 

message are set out under the tab. 
 

…->Output Variable Properties -> Highlights 
 

 
 
 
 
 
 
 

Depending on the condition of the variable, the “Trading Enabled” option makes it 
possible to give orders to open and close a position in the market. The parameters of 

such actions and the direction of the position itself are indicated under the “Trading” tab. 
 
 
 
 
 
…->Output Variable Properties ->Trading 
 
 

 
 
 

 
Later on, we will discuss this tab in greater detail. As previously mentioned, 

the same variable may be assigned several actions, and the same actions may be 
assigned to different variables. 

 
 For now, turn on the “Graphic Enabled” function under the “Name” tab. .  

 
…->Output Variable Properties ->Name -> Graphic Enable -> 

ON 
 

 With this command, you have assigned the action to the “Long” variable of 
bringing up the symbol to the price action chart. Select the “Graphic” tab and set 
its parameters. 
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…->Output Variable Properties ->Graphic-> 
 

-> Font - > Select Symbol -> 
 
 Select the size and the color that will show up on the screen: 
 

…->Output Variable Properties ->Graphic-> Size -> Medium ->Color -> Dark Blue 
 
 

 
 
 
 
 
 
  

Also, set the symbol position in relation to the price movement (above price, below price). 
 

 
Graphic -> Below Price Plot-> ON 

 
 
 

Click the “OK” button, but stay on the “Output” window. 
 
At this point, you have assigned an action to the “Long” variable and specified the parameters for it. If 

further changes and additions are deemed necessary to the variable’s actions, the user must bring up the 
“Studies Editor” component from the “Output” window and click the “Edit” button. 

 
Perform the same operations for the “Short” variable: 
 
Studies Editor -> Output -> New -> Output Variable Properties -> Name -> 

 
-> Var Name -> SHORT -> 
-> Name -> Signal SHORT -> 
-> Description -> Short:= CROSS (MA2, MA1); -> 

-> Graphic Enable -> ON -> Output Variable Properties -> Graphic -> Font -> -> 
-> Size -> Medium -> 
-> Color -> Red -> 
-> Above Price Plot -> On -> 
 
-> OK… 
 
Use the “Close” button to close the “Edit Trading System” window.  
 
The development of your strategy is now complete. The strategy can only generate and bring to the 

price chart the arrow signs pointing in the recommended direction of entry into the market according to your 
instructions. 

 
 Later, we will develop this strategy further and “teach” it to do much more, but even in such capacity it 

can be used to produce recommendations for market operations. Regardless of what might happen in the 
market and what opinions the user adopts, the strategy will remain unbiased and produce absolutely logical 
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results that are not subject to any influences. Such an approach reduces the market’s emotional influence on 
the trader. This is the main advantage of creating a proprietary trading strategy for conducting market 
operations. 

 
 

Step 4. Managing the Strategy’s Launch into Action 
 

Let us now check what we have done. For this purpose we’ll simply apply the strategy that we have 
developed and compare the results with Moving Average of Relative Strength Index indicator that we had 
created earlier, and which serves as the foundation for our strategy. 

 
The VT Trader trading platform includes features that make it convenient to launch and manage the 

trading strategy. There are several ways to implement this task, but the simplest and easiest way is to attach 
the strategy to an open price chart by right-clicking on the chart and opening the context menu.  

 
As we did earlier, run VT Trader in Demo mode and open a EUR/USD 1 hour chart so that it occupies 

the entire screen, with the Moving Average of Relative Strength Index indicator plotted on a separate frame 
underneath the chart.  

 
 
 

Your computer screen should look like the example above.  
 
Right-click the mouse on the open chart field, and highlight the “Add Trading System” entry, which will 

include Moving Average of Relative Strength System Trading Strategy that you have created. 
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…Chart EURUSD 1H -> right click -> Add Trading System -> 
-> Moving Average of Relative Strength System 

 
. 
 
 
 
 
 
 
 
 
 
 
Clicking the “OK” button in the “Trading System Properties” window permits us to change the 

parameters directing the signals to default settings. 
 
 
 

-> OK 
 
 
 
 
 

 
If everything was done correctly, you will see graphic symbols, in this case arrows, on the price chart. 
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Moving across the chart, compare the system’s signals to the readings of the indicator plotted below. At 
this point, you should understand where the red and blue arrows come from. If not, stop here and re-read the 
manual up to this point. 

 
You may remove the indicator from the chart, but in this case the system will continue to function and 

generate signals in the background.  
 
If you removed the indicator from the chart, restore it now. We will need it to make comparisons and 

understand how the trading strategy works. 
 
It is really advantageous that the strategy operates completely automatically and generates signals 

based on the conditions that you set yourself. The signals are plotted directly on the chart as arrows. Even 
considering that the system cannot trade for you yet, it has already become an important aide and generates 
signals that can be used as recommendations in conducting operations. All that the user has to do is “bite the 
bullet” and, regardless of what happens in the market and what doubts or thoughts enter your mind, the trading 
strategy silently and patiently gives signals for trading following only logic and common sense, removing the 
emotional impact of the market on the user during trading. 

 
It is important to understand that the trading system is now attached only to one given chart, i.e. 

EUR/USD 1h chart. Even if you close this price chart, and switch to a different currency pair to be analyzed, or 
a different time period, the system launched will operate in any case as long as the VT Trader platform is 
operational and the TS is not turned off by the user. 

 
Do not close this chart, but switch within the chart frame to  different currency pairs and time intervals. 

You will not see the trading system operate on other charts in the same window, although you can link each 
one of them to any trading strategy at your discretion.  

 
Return to the EUR/USD 1H chart. 
 
Switch to GBP/USD 1H chart. You will notice the absence here of the trading system, but you should 

link it with the help of the context menu to the Moving Average of Relative Strength System Trading Strategy: 
 

…Chart EURUSD 1H -> Chart EURUSD 1H ->right button -> Add Trading System -> 
-> Moving Average of Relative Strength System 

 
 Now you have two similar trading systems launched into operation on different currency pairs, even if 
the EUR/USD 1H chart is closed. In each particular case, the trading strategy that was launched operates in 
the background of VT Trader, continuing to research the price chart tick by tick according to the formula that 
you created and generate the signals that you specified. 
 
 This process is the same if you want to launch any trading system on any currency pair and time 
interval. They will all operate simultaneously. 
 
 Switch back to the EUR/USD 1H price chart. You see the signals in the form of arrows reflecting the 
trading strategy that was launched. Then by right-clicking the mouse,  bring up the context menu directly on the 
chart, find the entry “Attached Trading Systems” and select it. This is the second way to launch and manage 
the TS. 

 
 

 
Chart EURUSD 1H ->right button ->  

->Attached Trading Systems 
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 The “Trading System” window appears and lets the user manage the Trading Strategies. 
 
  

The “Trading System” window allows you only to manage the strategy, and only for the given currency 
pair and chart time period from which this window was opened.  In this case, it is only the EURUSD 1H chart. It 
should be noted that the above also refers to the way the chart is presented: whether BID or ASK prices were 
used to plot the charts. 
 
 In the main row, you see a list of Trading Strategies that were launched or are ready to be launched on 
this chart. 
 
  
 
 
 
 The headings “Instrument,” “Interval” and “Bid/Ask” display the currency pair, the chart interval and the 
mode of reflection of the price chart, from which this window was opened. 
 
 The “Name” column displays the names of trading systems available for launch on this chart. The 
“Status” column shows the system’s state at any given time. 
  

At present, the “Status” column may display only a few symbols combinations. 
 

The symbols  or  indicate whether the system is running in the automatic trading mode or not.  In 
other words, it shows whether the system is set to make trades according to the conditions set in the strategy’s 
formula. 

 
The symbols  or   indicate to the user whether the trading strategy brings the signals that were 

specified to the chart field or not (if such signals had been described in the formula). 
 
Accordingly: 

 
- The Trading Strategy shown here has been chosen and launched to make calculations on a 
given currency pair and chart period, but the signals and messages are not brought to the chart 
field and trading operations have not been launched for operation.  The strategy makes 

calculations but no actions are taken. 
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- This example shows that the attached Trading Strategy has been launched for operation, makes 
calculations and all symbols and actions are switched on, if prescribed for, except for the 
management of trading operations in the automated mode. This is the main mode for launching the 

system and projecting it to the price chart of a currency pair. It makes sense to use this mode for TS testing or 
considering its signals as recommendations for market operations that are conducted manually. All systems 
are launched in this mode by default. 
 

- The Trading Strategy here has been launched, calculations are made, and all signals and 
operations that are described in its formula are switched on and displayed. The System itself 
manages trading operations in the automated mode. This is the mode for launching the system to 

conduct trading operations automatically. This mode should be used to test the TS in a VT Trader demo 
account.  
 

- In this case, the system attached to the currency pair conducts operations in a background mode, 
but signals with respect to actions taken are not brought to the chart. This mode can be used in a 
situation when it is necessary to accomplish an additional analysis of the market, and you want to 

remove the displayed symbols without shutting down the entire TS.  
 

 Just try to remember a simple rule: 
 
The symbols   or  display the launch/shut down of the TS for trading and relate only to a specific 

currency pair and chart period, even if the chart for this pair was closed.  
  
 The symbols  or  indicate display/absence of signals from the attached TS and may be brought to 
any chart window that displays the currency pair, to which the strategy was attached. 
 
 Let’s assume that we open two windows containing the charts of the same currency pair and the same 
time period (EUR/USD 1H). The TS that was launched will operate only on this currency pair and the time 
period selected However, the signals from the system may be brought, if necessary, to any open window for 
the same currency pair and the same interval (EUR/USD 1H), or to both windows at the same time. There, you 
may create any indicators and oscillators. They would not interfere at all with the operation of the TS. 
 
 So, the system may be attached to any chart interval of the currency pair and in this state it can be 
launched for automated trading, as well as displaying symbols for recommendations, but in both cases the 
system continues to operate in background mode. Everything depends on what the user wants to do. If the 
user wants to apply the strategy’s signals as recommendations for his own actions, he may attach the strategy 
to the chart and only make it bring the signals to a chart. If the user has trust in the attached strategy, or 
satisfied with the results that were produced by its signals, he/she may turn on the strategy’s automated mode 
and monitor it from time to time. 

  
For that purpose, the right side of the “Trading System” window contains a 

number of buttons. 
 

The “Add” button brings up the “Trading Systems Select” 
window. It displays the list of Trading Strategies, and by 

highlighting an item in the list and clicking the “Add” button, you will be able to add 
it to a chart. 
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The “Edit” button brings up the “Trading System Properties” window that is used to edit the 
Trading System’s properties which were set by default when it was created. We will not go into 

detail at this point. The peculiarities will be discussed in a separate chapter. Note that when the “Complete Bar” 
formula calculation mode is turned on, one may change only the number of lots in each transaction, and any 
other parameters would not make any sense in that case.  
 
 

The “Delete” button deletes the Trading Strategy selected by the cursor. To be precise, the TS 
is not actually removed from the VT Trader platform, but simply unattached from the chart and 

deleted from the list of systems attached to a given currency pair. It does not matter what state the system was 
in. All signals disappear, and no actions are taken. If at this point, the TS had opened positions, they would 
have to be closed manually by the user.       
 

 
The “Attach/Detach” button instructs the system to bring up signals to the particular currency 
pair’s chart. This is confirmed by the symbol  or  in the line of the attached system in the 

same window.  
 
Select the line containing the name of the Trading Strategy with the mouse and click the 

“Attach/Detach” button several times. You will be able to see how signals brought up by the system appear and 
disappear in the background. 

 
-> Trading Systems (Chart EURUSD 1H) -> Moving Average of Relative Strength System -> 

-> Attach/Detach -> Attach/Detach -> Attach/Detach -> Attach/Detach 
 

 The TS may be launched to conduct trading operations in the automated mode, or switched off. The 
signals will be brought up according to what you choose.  
 

The “Start/Stop” button turns the TS on/off in the automated mode. That is confirmed by the 
symbols  or  in the line of the attached system of the same window. The symbol   

indicates the state of readiness for launch, and the symbol  will inform the user that the system is currently 
running in automated mode. Therefore, as soon as the condition that was specified in the Strategy’s formula 
becomes true, the appropriate action will be taken. 
  

 Select the line containing the name of the Trading Strategy with the mouse and click the 
“Start/Stop” button. You can see how the symbol changes. Since you have not yet created or specified the 
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conditions for opening positions in this TS, no changes will be made to your deposit and no transactions will be 
made. 
 

-> Trading Systems (Chart EURUSD 1H) -> Moving Average of Relative Strength System -> 
-> Start/Stop -> Start/Stop -> Start/Stop -> Start/Stop 

 
If you highlight the TS and click the “View Events” button, the “Trading System Events” 
window will open. This window shows the exact date and time the signal was triggered.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You should recall that during the development of the strategy’s formula, we entered the names of 
variables “Long” and “Short” and attached certain actions to them. You can see on the above example exactly 
when the system received signals in relation to the values of the price chart. The readings are listed in their 
entirety, from the very first to the very last of the data displayed on the screen. By default, it is set to 500 bar 
values and can be adjusted from the “VT Navigator” window by following the following path. 

 
 VT Navigator-> Options -> Properties ->General -> General Properties -> History Length ->500 

 
 As a side note, if your computer’s processor is slow or you have numerous applications running, you 
should not increase the number of bars on the charts indefinitely. We recommend that this value be set at 250, 
which is usually more than enough for the trader’s purposes. In any case, you can always switch to a larger 
scale chart of the currency pair and observe price history for a longer period.  

The “Input” tab lists the names and types of variables 
that are entered for the purpose of calculations. These can be 
changed by the user if needed without altering the main 

functions of the 
system.  

 
 
 
 
 

The “Params Enabled” button opens the “Trading System Events” window, which enables the 
user to assign or cancel certain actions to the variables that were specified in the “Output” 

window.  
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The checked boxes show what actions are to be taken 
by the specific parameters while implementing the 
condition assigned to a given variable. If an action of 
this system is not required, it can be removed without 
changing the formula itself by clearing the check box 
next to the parameter and its action. In the same 
manner, you can also designate a new action. 
However, we do not recommend doing this unless 
absolutely necessary.  Before doing so, the user 
would have to select the properties of an action for a 
given parameter when creating or editing a trading 
system based on the objectives of his/her Trading 
Strategy. Otherwise, the actions will be applied by 

default. 
 
 Try to check and uncheck the box next to the “Long” parameter. You will see blue arrows pointed up 
appearing and disappearing from the chart, as per the action you attached to the “Long” parameter.  
 

Trading System Events -> Long -> Graphic -> Off -> Ok ->… 
Trading System Events -> Params Enable -> Long -> Graphic -> On -> Ok ->… 

 
Click the “Close” button to close the “Trading Systems” window.  
 

 
 
Moving across the price chart, carefully observe the readings of the “Moving Average of Relative 

Strength Index” indicator, as well as the signals generated by “Moving Average of Relative Strength System” 
Trading Strategy, built upon this indicator. There is certainly room for improvement but the strategy is efficient 
and applicable. We once again remind the user that at this stage we are not trying to develop an ideal, 
sophisticated Strategy. What we are trying to do here is to simply use this example to show the possibilities of 
building such strategies based on the universal VT Trader trading platform. 
 
 Now, click the button at the bottom of the chart panel to clone the EUR/USD 1H chart:  
 

 
 

Chart EUR/USD 1H -> Clone Chart … 
 
 

 
 Choose a convenient layout for the charts on your monitor screen. Make sure that the EUR/USD chart 

was cloned together with the Trading Strategy attached to it. If, when the chart was cloned, the Trading System 
was launched into operation in the trading mode, it will be transferred as such to the new chart. However, that 
does not mean that it will open positions twice, for each chart. The strategy can generate signals for any 
number of the charts of a given currency pair, but the positions will be opened only once whenever the 
condition for a given instrument is met and only for a given account within the VT Trader platform. This issue 
will be discussed in greater detail in the Annex to this manual. For now, the user must distinguish between the 
situation where the strategy is attached to a chart and a situation where it is launched to conduct trading 
transactions. 

 
Switch one of the open charts to GBP/USD 1H and check the signals from the TS attached to it. 
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 Without shutting down VT Trader close the chart windows and follow the following path:  
 

 
 
 
 

VT Navigator -> Tools ->Running Trading Systems… 
 
 
 
 
 

 
 
 You will see in the new “Trading Systems” window that the Trading Systems launched for EURUSD 1H 
and GBPUSD 1H are still running in background mode, even though the charts are closed: 
  
 
 

 This presents one more way to manage the operational TS. This window is similar to the one we 
previously studied. It can be used to manage the parameters of the Trading Strategies, their launch into 
operation and suspension for any currency pair and period, and for the entire VT Trader platform, even when a 
given chart is not open. Still, you are not able to control the display of signals on the chart. That can be done 
only directly from the chart of the currency pair itself. This allows you to manage your Trading Strategies in the 
VT Trader system even if you are not following them on the price chart.  
 

It is not recommended to simultaneously launch multiple Trading Systems arbitrarily because the 
system makes the appropriate calculations in accordance with its formula, regardless of whether the signals 
are generated or whether the system is operational in trading mode or is not operating at all. Running multiple 
Trading Systems can overload your computer.  
 
 You can delete Strategies in the “Trading Systems” window by simply clicking the “Delete” button.  

 
In the next section of the manual we will learn how to optimize the “Moving Average of Relative 

Strength System” Trading Strategy. 
 
 If you experienced any difficulties in understanding these concepts, you should review the previous 
sections of the manual. 
 
 

Step 5. Further Improvement of the Trading Strategy. 
 

Designating Actions for Conducting Trading Transactions to the Conditions 
 

 
 In case you logged off from the VT Trader platform, launch it again in demo mode. Open the EUR/USD 
1H chart and create the “Moving Average of Relative Strength Index” indicator by taking the steps we 
discussed earlier:  
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Chart EUR/USD 1H -> right-click -> Add Studies -> Moving Average of Relative Strength Index -> OK … 

 
Follow this path to make sure that there are no Trading Systems currently attached: 
 

VT Navigator -> Tools ->Running Trading Systems->…->OK… 
 

. 
We will now enable the TS to open and close positions, and also make it possible to change the entry 

parameters and use the Alerts as a way to check that they are correct. 
 
 Even the best trading systems in the world know nothing about the specific character of the Market, and 
they certainly do not know how to operate on their own. The only language they understand is logic and 
mathematics. However, the developers of the VT Trader platform designed the systems to issue an order to 
open a position in the appropriate direction. The TS can issue orders only for Buy or Sell transactions. It is very 
important to understand that in order to close an existing Buy position, the system must issue a Sell order 
based on a “true” condition. Another Sell order may be issued from the same spot, if this was provided for in 
the Trading Strategy formula.  
 
 Similarly, in order to close a Sell position and simultaneously open a Buy position, two Buy orders will 
be required: one to liquidate the previously opened Sell position and the other to open a new Buy position.  
 

Let us examine the Trading Strategy that we developed. Its formula is shown below: 
……………………………………………………………………………………. 

 
 {Relative Strength Index} 
 
 RSI_r:= (CLOSE - ref(CLOSE,-1));  
 RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),14) /                 
 Wilders(if(rsi_r<0,Abs(rsi_r),0),14);  
 RS:= 100-(100/(1+rsi_rs)); 
 
 {Moving Average of Relative Strength Index} 
 
 MA1:=MOV (RS, 10, E); 
 MA2:=MOV (RS, 30, E); 
 
 {Signal Long and Short} 
 
 Long:= CROSS (MA1, MA2); 
 Short:= CROSS (MA2, MA1); 

……………………………………………………………………………………. 
 
 
The first component is as follows:  
 
{Relative Strength Index} 
 
RSI_r:= (CLOSE - ref(CLOSE,-1)); 
RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),14) / 
Wilders(if(rsi_r<0,Abs(rsi_r),0),14); 
RS:= 100-(100/(1+rsi_rs)); 
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It calculates the Relative Strength Index indicator for the Trading System. 
 
Here, we have the second component:   
 
{Moving Average of Relative Strength Index} 
 
 MA1:=MOV (RS, 10, E); 
 MA2:=MOV (RS, 30, E); 
 
It calculates two moving averages – MA1 with a 10 day interval and MA2 with a 30 day interval from the 

“Relative Strength Index” indicator. 
 
 And this third component makes it possible to estimate the MA1 and MA2 crossovers: 
 
  {Signal Long and Short} 

 
 Long:= CROSS (MA1, MA2); 
 Short:= CROSS (MA2, MA1); 

 
When the MA1 moving average exceeds the MA2, the short-term variable “Long” becomes equal to 1, 

and in accordance with the associated action, it displays a symbol (blue upward pointed arrow) on the price 
chart.  
 

When the MA1 moving average is less than the MA2, the short-term variable “Short” becomes equal to 
1, and in accordance with the attached action, it displays a symbol (red arrow pointed downward) on the price 
chart. 

 
 
We will now see what happens if, in addition to displaying the symbol on the price chart, the “Long” and 

“Short” variables were set to actually place trades in the direction of the arrows on the price chart. 
 
 
Let us assign the “Long” variable to open Buy positions and the “Short” variable to open Sell positions. 

Please, examine carefully the “Moving Average of Relative Strength Index” indicator located under the price 
line: 

 
 
 
 
 
 
 
 
 
 
 
 
 
When the red MA1 moving average crossed above the blue MA2 moving average line, the “Long” 

parameter was “true” for a short time (i.e. equal to 1, and equal to 0 the rest of the time), and the order to open 
Buy position was issued. 
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 When the red MA1 line crossed below the blue MA2 line, the Short parameter was briefly “true” (equal 
to 1, and equal to 0 the rest of the time). The order to open a Sell position would have been issued, but would 
only close the previously opened Buy position (i.e. become a counter position) and not open a new Sell 
position. This would run counter the correct operation of the Trading Strategy. 

 
So for now, let us leave the Long and Short variables alone. They fully meet their requirements. Let us 

create new variables that are able to track open and close positions in one direction on our conditions and by 
themselves. 

 
Follow the path below. Open the Trading Strategies Builder module, find the “Moving Average of 

Relative Strength System” that you have created according to this manual, and open it for further editing. Move 
to the “Formula” tab: 

 
VT Navigator -> Tools -> Trading Systems->Edit Trading Systems-> Moving Average of Relative Strength 

System ->Edit ->Studies Editor ->Formula... 
 

 
 
 
 
 
 
 
 
Now we will create variables, the “true” condition of which would trigger an order for opening the Buy 

position (we will call it OpenBuy), and that position would be closed (we will call it CloseBuy) by issuing an 
order to open a Sell position, that would play the role of the closing position for the previous Buy position, 
which was opened in accordance with OpenBuy. 

 
 
 
OpenBuy:= condition ; {order to open  BUY position}  
CloseBuy:= condition ; {order to open SELL position, will close the position opened in accordance with  

OpenBuy} 
 
Accordingly, we will also create variables, the “true” condition of which would trigger the order to open a 

Sell position (we will call it OpenSell), and it would be closed (CloseSell) by issuing an order to open a Buy 
position, that would play the role of the closing position to the previous Sell position, which was opened in 
accordance with OpenSell. 

 
OpenSell:= condition ; {order to open  SELL position}  
CloseSell:= condition ; {order to open  BUY position, will close the Buy position opened in accordance 

with OpenBuy} 
 
Because the condition to open a position is the “true” state defined by the “Long” parameter, and vice-

versa for the “Short” parameter, the variables can be estimated by the following: 
 
OpenBuy:= Long ; {order to open  BUY position}  
CloseBuy:= Short ; {order to open  SELL position that would close the  Buy position opened in 

accordance with  OpenBuy} 
 
And:  
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OpenSell:= Short ; {order to open a SELL position}  
CloseSell:= Long ; {order to open BUY position that would close  Buy position opened in accordance 

with  OpenBuy} 
 
If this is clear, we will move on. Take a look at the following formulae, which are the opening position 

components: 
 
{OpenBuy and CloseBuy} 
 
OpenBuy:= Long ;  
CloseBuy:= Short ; 
 
{OpenSell and CloseSell} 

 
OpenSell:= Short ;  
CloseSell:= Long ;  
 
 
When one of the conditions for the “Long” or “Short” variables (as an example, we will choose “Long”), 

is “true” and MA1 crosses above MA2, because Long:= CROSS (MA1, MA2), the OpenBuy and CloseSell 
variables (as you can see in the opening positions component) also become equal to 1, since OpenBuy:= Long  
and CloseSell:= Long.   

 
 In this case, in accordance with the action associated with these variables, each will issue an order to 

open a Buy position. One of these positions is designed to close a previously opened Sell position.  
 
 But suppose there is no previously opened Sell position. The result would differ from what we would 

have expected to see. Two positions in the same direction (in this case for Buy) would be opened. 
 
It is necessary to properly define the conditions for variables, for which an action will be associated to 

conduct transactions. 
       
In this case: 
 
OpenBuy:= Long ; will be implemented only if “Long” is “true”.  
CloseBuy:= must be “true” not only when “Short” is “true”, but also when a position was opened through 

the OpenBuy variable. In other words, the OpenBuy and CloseBuy variables must be linked to each other in 
some way. The CloseBuy variable operates only in order to close positions that were previously opened by 
OpenBuy, and for that purpose CloseBuy receives a signal from OpenBuy. 

 
Consequently, the reverse is true:  
 
OpenSell:= Short ; will be implemented only if Short is “true”. As for:   
CloseSell:= must be true not only when “Long” is “true”, but also when a position was opened through 

the OpenClose variable. In other words, the OpenSell and CloseSell variables must be linked to each other in 
some way. The CloseSell variable operates only in order to close positions that were previously opened by 
OpenSell, and for that purpose CloseSell receives a signal from OpenSell. 

 
 
It should be clear that for the Trading Strategy to function properly, we must link the OpenBuy variable 

with CloseBuy. CloseBuy can be implemented only if OpenBuy was previously “true” and, accordingly, an 
action was taken. 
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 Respectively, we must link the OpenSell variable with CloseSell. CloseSell can be implemented only if 
OpenSell was previously “true” and, accordingly, an action was taken. 

 
In order to link the two conditions to each other, we recommend using the EventCount(“param”) 

function, which will return the number of “true” occurrences of the condition of the parameter, as in the 
following examples. They are not case sensitive. 

 
EventCount(“OpenBuy”) – will return the number of “true” states for the OpenBuy parameter 

. 
EventCount(“CloseBuy”)– will return the number of “true” states for the CloseBuy parameter 
 
EventCount(“OpenSell”) – will return the number of “true” states for the OpenSell parameter 
 
EventCount(“CloseSell”)– will return the number of “true” states for the CloseSell parameter 
 
 
We can now introduce the following changes into the opening positions component: 
 
 {OpenBuy and CloseBuy} 
 
OpenBuy:= Long and (eventCount('OpenBuy')= eventCount('CloseBuy')); 
CloseBuy:= Short and (eventCount('OpenBuy')>eventCount('CloseBuy')); 
 
{OpenSell and CloseSell} 
 
OpenSell:=Short and (eventCount('OpenSell')= eventCount('CloseSell')); 
CloseSell:= Long and (eventCount('OpenSell')>eventCount('CloseSell')); 
 
 
Look at the line with the OpenBuy condition. It says that the OpenBuy variable may be equal to 1, and 

this means that the opening of a Buy position will occur only if MA1 crosses above MA2 (Long=1). The number 
of “true” states for opening BUY positions must be equal to the number of closed ones through the CloseBuy 
variable.  

 
In other words, if there were Buy positions opened through the OpenBuy variable, and if they are all 

closed through the CloseBuy variable, it will become “true” when MA1 crosses MA2. A new position in the 
same direction cannot be opened, if there is at least one position in that direction. 

 
The line CloseBuy says that the Buy position may be closed only if MA1 crosses below MA2 (Short=1), 

and there should be a position created through the OpenBuy variable 
[eventCount('OpenBuy')>eventCount('CloseBuy')]. 

 
The OpenSell variable may be equal to 1, and this means that the opening of the Sell position will occur 

only if MA1 crosses below MA2 (Short=1). The number of “true” occurrences triggering the opening of Sell 
positions must be equal to the number of their closings through the CloseSell variable.  

 
So, if there were Sell positions opened through the OpenSell variable, and if they are all now closed 

through the CloseSell variable, only when the MA1 and MA2 crossover occurs will it become “true”. A new 
position in the same direction cannot be opened if at least one position in that direction exists. 

 
The line CloseSell says that the closing of the Sell position may occur only if the MA1 crosses above 

MA2 (Long=1), but there should also be a position opened through the OpenSell variable 
(eventCount('OpenSell')>eventCount('CloseSell')). 
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So now we are able to control the opening and closing of positions in the same direction. We can safely 

conclude that the opening positions component’s code is correct. 
 
We recommend using such a template for controlling positions when proprietary Trading Strategies are 

developed. To make your Trading System easier to understand while it is being tested, it is recommended that 
you assign one action to each condition. In this case, it is easier to search the TS code for mistakes. For 
example, we may specify that if a certain condition is met, the symbol will be displayed and simultaneously a 
position will be opened. Also, two variables may be designated, and the same condition may be assigned to 
them. In the first case the symbol will be displayed only when the strategy operates in the Automated Trading 
mode and the operation performed; in the second case it will be always be displayed when the condition is met 
that is included into the formula for processing orders. 

Check and correct, if necessary, the code of the Trading Strategy’s formula (you can simply copy it from 
this document and replace the existing code) in the field under the Formula tab:  

 
 VT Navigator -> Tools -> Trading Systems->Edit Trading Systems-> Moving Average of Relative Strength 

System ->Edit ->Studies Editor ->Formula... 
 

Now it should read as follows: 
 

……………………………………………………………………………………. 
 

{Relative Strength Index} 
 
RSI_r:= (CLOSE - ref(CLOSE,-1));  
RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),14) /                 
Wilders(if(rsi_r<0,Abs(rsi_r),0),14);  
RS:= 100-(100/(1+rsi_rs)); 
 
{Moving Average of Relative Strength Index} 
 
MA1:=MOV (RS, 10, E); 
MA2:=MOV (RS, 30, E); 
 
{Signal Long and Short} 
 
Long:= CROSS (MA1, MA2); 
Short:= CROSS (MA2, MA1); 
 
{OpenBuy and CloseBuy} 
 
OpenBuy:= Long and (eventCount('OpenBuy')= eventCount('CloseBuy')); 
CloseBuy:= Short and (eventCount('OpenBuy')>eventCount('CloseBuy')); 
 
{OpenSell and CloseSell} 
 
OpenSell:=Short and (eventCount('OpenSell')= eventCount('CloseSell')); 
CloseSell:= Long and (eventCount('OpenSell')>eventCount('CloseSell')); 
 

……………………………………………………………………………………. 
 
Move now to the “Output” tab of the “Studies Editor” window, and follow the path below to assign the 

required actions to the variables. 
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For the OpenBuy variable, include the function of conducting trading operations: 
 
Studies Editor ->Output->New->Output Variable Properties->Name-> 
->VarName ->OpenBuy-> 
->Name->Open Buy-> 
->Description->Open Position Buy-> 
->Trading Enabled->ON… 
 
Then select their properties under the “Trading” tab. Specify the type of Buy operation: 
 
Output Variable Properties->Trading->BUY… 
 
Also specify the number of confirmations of this condition at each new price tick, if the “Each Tick” 

mode was switched on under the “Studies” tab of the “Studies Editor” panel, so that an accidental price spike 
will not trigger the order for closing the position when calculating the Strategy’s formula.  

 
->Event Count->5… 
 
We recommend that you avoid lowering this parameter. If this reading for accepting the “true” state of a 

condition is not available during the formation of a bar, the order will be implemented upon the bar’s 
completion, if the condition triggering a given action becomes “true.” This parameter is adjusted in a separate 
manner during the testing stage of the Trading Strategy for a given instrument, based on its volatility at 
different time intervals.  

 
Click the “OK” button. The actions for the OpenBuy variable are adjusted. 
 
->Ok 
 
Keep the “Studies Editor” window open. In a similar manner, adjust the actions for other variables of the 

Strategy: 
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For the CloseBuy variable, follow this path: 
 
Studies Editor ->Output->New->Output Variable Properties->Name-> 
->VarName ->CloseBuy-> 
->Name->Close Buy-> 
->Description->Close Position Buy-> 
->Trading Enabled->ON… 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Output Variable Properties->Trading->SELL-> 
->Event Count->5… 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

Click “OK”:           ->Ok 
 
 
For the OpenSell variable: 
 
Studies Editor ->Output->New->Output Variable Properties->Name-> 
->VarName ->OpenSell-> 
->Name->Open Sell-> 
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->Description->Open Position Sell-> 
->Trading Enabled->ON… 
 
->Output Variable Properties->Trading->SELL-> 
->Event Count->5… ->OK 
 
For the CloseSell variable: 
 
Studies Editor ->Output->New->Output Variable Properties->Name-> 
->VarName ->CloseSell-> 
->Name->Close Sell-> 
->Description->Close Position Sell-> 
->Trading Enabled->ON… 
 
->Output Variable Properties->Trading->BUY-> 
->Event Count->5… ->OK 
 
Do not close the “Studies Editor” window yet. Check again how the actions have been adjusted using 

the “Edit” button. Carefully check the syntax of all the parameters. Very often, the most common mistake can 
be found in the syntax.  

 
The Trading Strategy is almost ready for implementation. But there are still a few more steps to be 

taken. At the beginning of this manual, we mentioned that it would be advantageous to be able to adjust the 
parameters of entry data when the Strategy is displayed on the chart, without having to change the formula 
itself. We should now finish with that issue. This will turn your first Trading Strategy into a fully functioning 
product that meets the requirements of the savviest traders.  

 
Proceed now to the next step, and correct the Trading Strategy by following the instructions. 
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Step 6. How to designate and correct variable entry parameters of the Trading Strategy 
 
 
Based on the task set before us by the author of the Trading Strategy, the only values that can be 

changed are: the period of the Relative Strength Index that is the foundation of the TS, and periods of MA1 and 
MA2 moving averages (their crossover is a signal to conduct operations). The type of moving averages 
remains the same. They should all be exponential. 

 
You should now be on the “Output” tab of the “Studies Editor” window.   

 
VT Navigator -> Tools -> Trading Systems->Edit Trading Systems-> Moving Average of Relative Strength 

System ->Edit ->Studies Editor ->Output... 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click on the “Formula” tab and look at the following component: 
 
{Relative Strength Index} 
 
RSI_r:= (CLOSE - ref(CLOSE,-1));  
RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),14) /                 
Wilders(if(rsi_r<0,Abs(rsi_r),0),14);  
RS:= 100-(100/(1+rsi_rs)); 
 
 
And: 
 
{Moving Average of Relative Strength Index} 
 
MA1:=MOV (RS, 10, E); 
MA2:=MOV (RS, 30, E); 
 
You will notice that we have specified that the Strategy’s formula will include RSI with the period of 14 

days, and moving averages MA1 and MA2 with 10 and 30 day periods respectively. 
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We will now assign new variables for the periods that could be changed in the process of the 
implementation of the TS. 

 
For the RSI, we’ll call the variable PerRSI (abbrev. from Period RSI), and for MA1 and MA2 - PerMA1 

and PerMA2 respectively.  
 
Make the necessary changes in these components. They should now read like the following: 
 

{Relative Strength Index} 
 

RSI_r:= (CLOSE - ref(CLOSE,-1));  
RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),PerRSI) /                 
Wilders(if(rsi_r<0,Abs(rsi_r),0),PerRSI);  
RS:= 100-(100/(1+rsi_rs)); 

 
{Moving Average of Relative Strength Index} 
 
MA1:=MOV (RS, PerMA1, E); 
MA2:=MOV (RS, PerMA2, E); 

 
 
 
 
 

Move to the “Input” tab and specify the new variables. 
 
For PerRSI: 
 
Studies Editor ->Input->New->Name->no name->PerRSI-> 
->Display Name-> Period RSI -> 
->Type ->integer -> 
->Default ->14 
 
For PerMA1:  
 
Studies Editor ->Input->New->Name->no name->PerMA1I-> 
->Display Name-> Period MA1 -> 
->Type ->integer -> 
->Default ->10 
 
For PerMA2:  
 
Studies Editor ->Input->New->Name->no name->PerMA1I-> 
->Display Name-> Period MA2 -> 
->Type ->integer -> 
->Default ->30 
 
Now everything is ready. Assuming no mistakes were made in the syntax of the variables, the “OK” 

button will close the “Studies Editor” window. Otherwise, an error message is generated. If that happens, find 
and correct the mistake. 
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The aforementioned actions make it possible for the user, when activating the Strategy, to change the 
periods of the RSI and the MA1 and MA2 moving averages. The “Ok” button lets you move to the “Edit Trading 
System” window. Use the “Close” button to close it. 

 
Apply the Strategy directly to the price chart. 
 

Chart EURUSD 1H -> right Bottom -> Add Trading System -> Moving Average of Relative Strength System -> 
one click mouse.. 

 
 
In the pop-up window, you will see the names assigned to the variables (PerRSI – Period RSI, PerMA1- 

Period MA1, PerMA2- Period MA2). They are ready to be changed from the default settings (14, 10, 30 
respectively). 

 
 
 
 
 
 
  

 
 
 
 
 
 

 
Close this window using the “Cancel” button. 
 
Let us make ourselves clear. Imagine what would happen if, in the above window, the user specifies 

Period MA1 as equal to 30, and Period MA2 equal to 10, or just changes the MA2 period to a value less than 
period MA1. This may happen in real life and at the worst time possible. Such a move would completely ruin 
the notion of the Trading Strategy. That is why it is necessary to either exclude such a possibility altogether or, 
even better, introduce the necessary controls. That is exactly what we are going to do. 

 
Bring up your Strategy for editing and go to the “Formula” tab. 

 
VT Navigator -> Tools -> Trading Systems->Edit Trading Systems-> Moving Average of Relative Strength 

System ->Edit ->Studies Editor ->Formula.. 
 
Add a new variable to the strategy. Let us call it “Error.” Create the following condition for it. Let it 

assume the “true” value when there is an error in the parameter data entered, specifically: 
 
 
{Control Error} 
 
Error:= (PerMA1=0 or PerMA2=0 or PerRSI=0) or (PerMA1>=PerMA2); 
 
In other words, the entered parameters should not equal 0 (PerMA1=0 or PerMA2=0 or PerRSI=0), the 

MA1 period should be less than the MA2 period (PerMA1>PerMA2), and those periods should not be the same 
(PerMA1=PerMA2). If these conditions are not met, the Error variable becomes equal to 1. 
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 Because the Strategy should not take action under these circumstances, we will block the conditions 
with the Error variable. If there is a mistake in the parameter data entered, Error=1, and the “not Error” script 
will equal zero in this case. And, consequently, when there is no error, Error =0, and “not Error” will return to 1.  
 

We will now change the Strategy’s formula. The final version of the TS formula is as specified below 
(you may copy this if you wish): 

 
 

……………………………………………………………………………………. 
 
 

{Control Error} 
 
Error:= (PerMA1=0 or PerMA2=0 or PerRSI=0) or (PerMA1>=PerMA2); 
 
{Relative Strength Index} 
 
RSI_r:= (CLOSE - ref(CLOSE,-1));  
RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),PerRSI) /                 
Wilders(if(rsi_r<0,Abs(rsi_r),0),PerRSI);  
RS:= 100-(100/(1+rsi_rs)); 
 
{Moving Average of Relative Strength Index} 
 
MA1:=MOV (RS, PerMA1, E); 
MA2:=MOV (RS, PerMA2, E); 
 
{Signal Long and Short} 
 
Long:=not Error and CROSS (MA1, MA2); 
Short:=not Error and CROSS (MA2, MA1); 
 
{OpenBuy and CloseBuy} 
 
OpenBuy:=not Error and Long and (eventCount('OpenBuy')= eventCount('CloseBuy')); 
CloseBuy:=not Error and Short and (eventCount('OpenBuy')>eventCount('CloseBuy')); 
 
{OpenSell and CloseSell} 
 
OpenSell:=not Error and Short and (eventCount('OpenSell')= eventCount('CloseSell')); 
CloseSell:=not Error and Long and (eventCount('OpenSell')>eventCount('CloseSell')); 
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By changing the Strategy’s formula, you have corrected it and made it ready for implementation. 
  
There is one item that is still open for correction 

 
Move to the “Output” tab and set the System so that if the entry parameter data are wrong, a sound file 

could be simultaneously played along with the error message appearing on the screen. The operations are as 
follows: 
 

For the Error variable: 
 
 

Studies Editor ->Output->New->Output Variable   
Properties->Name->… 
 
->VarName ->Error-> 
->Name-> Mistake of entrance parameters -> 
->Description-> Mistake of entrance            parameters-> 
->Alerts Enabled->ON… 

 
->Output Variable Properties->Alerts-> 
->Alerts Message ->Error: Mistake of entrance parameters-> 
->Alert Sound File ->Choose the sound or melody that you want played.   
 
 
  

 
 
 

 
 
 
 

Press “Ok.” -> Ok 
 
 
 There is one final addition. Move to the “Studies” tab of the “Studies Editor” window, and insert the 
following line into the “Label Mask” field: 
 

MA RSS (%PerRSI%, %PerMA1%, %PerMA2%) 
 
This will make it possible later on to observe what values of the entry parameters are used when the 

Trading Strategy is launched for operation. Using the “Ok” and “Close” buttons, close all windows. Your first 
Trading Strategy is now complete. Restart the VT Trader application and verify that you are in demo mode. 
Open any chart on a short interval (5m). Launch the Trading Strategy in any way that is convenient. Everything 
should function properly. Good luck in trading! 
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Annex 1 
 

Characteristics of the Modes of Operation of Trading Strategies and Formulas 
for Decision-Making in Trading 

 
 
 
        Each bar in a bar chart consists of large number of ticks. At any time each one of them may cause the 
condition to become equal to 1 (true). That triggers the action attached to that condition. The bars within that 
period are used only to calculate the price movement history. Each bar can be described with several 
parameters: Date, Time, and Prices (High, Low, Opening and Closing).  
 
         The closing price is particularly important for any decision made by the Trading System (TS). These 
decisions are based on historical price data. The data that is entered in accordance with the conditions 
described in the TS reflect the bars’ Highs, Lows, Closing and Opening Prices. 

 
         The user may enter the TS formula into the "Complete Bar" section. In this case the Trading Strategy 
awaits the completion of the bar chart for the period that was used to launch the TS. The decision whether a 
condition is true or false is made only after this period has ended. If the condition is true the attached action or 
actions are taken. A TS formula can also be entered into “Each Tick,” but that will be discussed later. 
 

At present time the Trading System may operate in two modes. 
   
 

The Modes of Launching the TS 
 

         The TS may operate exclusively in a mode where the signals are transferred to the price chart. The 
user may consider these signals as recommendations when deciding whether or not to open a position. For 
simplicity’s sake, we’ll call this the Recommendations Mode. 
 
         Another mode that can be used is the Automated Trading Mode where the system itself makes a 
decision to trade and the trader’s account is accessed automatically for this purpose. 
 
        Each of the two modes may be activated separately in the "Each Tick " or "Complete Bar" sections. 
This is confirmed by the appropriate signals in the Trading System’s properties window attached to the price 
chart. To access it, follow the following path: 
 

Chart ->right click -> 
->Attached Trading Systems -> Trading System - >Edit 

         
 
 
        A third option is to use both modes together. 
         
         The user must be able to distinguish between these two modes. The Recommendations Mode applies 
only to the price chart to which the Trading Strategy is attached. Depending on the user’s preferences, the 
Recommendations Mode may be displayed on any price chart in the research field. The Automated Trading 
mode, on the other hand, applies both to the currency pair and the price chart interval, and also to the entire 
VT Spot trading platform and, in particular, to the user’s account that is used for transactions. 
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It is very important to note the following:  
 
            Only one Trading System may be launched in the Automated Trading mode at any one time for each 
account and currency pair, regardless of the time interval researched. The system will issue a warning and 
cancel any attempt to launch the same or different Trading Strategy on the same account and currency pair, 
unless the original strategy is shut down. 
 
         In the Recommendations mode an unlimited number of strategies may be launched at any time. The 
user may choose any price chart and time interval for a currency pair without any reference to a particular 
account. The user will only have to change the properties of the signals displaying the attached strategies by 
altering the systems, so that their signals could be distinguished. 
 
         For example:  
         
         Let’s assume that two currency pairs, EUR/USD (1 Hour chart) and USD/CHF (1 Hour chart) are 
examined. Respectively, the user has two accounts – “ACC.001” and “ACC.002.” 
 
         The Trading Strategy “TS 1” is attached in the standard fashion to EUR/USD 1H chart, and the 
Recommendations mode has been chosen for the 1H period. If we switch to a different time interval chart for 
the EUR/USD currency pair (for example, 5 minutes, 30 minuts or 4 Hour), the same signals from the Trading 
Strategy on the 1H chart will be present on the new chart.  A Trading Strategy can be seen on any time interval 
chart for the same currency pair. The user must bring up or switch off the display of the signals on the price 
chart in order to view them. When the user moves from one chart time period to another, this function is not 
operational by default (the signals are not displayed).         

 
By switching to EUR/USD 30M chart, follow the path shown below. This is telling the system to select 

the Trading Strategy TS1 attached to EUR/USD 1H and display the signals from on a 30 min chart. 
 

Chart (EURUSD 30m)->right click  ->Attached Trading Systems -> 
 ->Trading System - >TS (EURUSD 1h) -> Attach/Detach 

 
         The user can also attach a Trading Strategy “TS2,” and, similarly, see its signals on the EUR/USD 1H 
chart together or separately from the TS1 signals. 
 
         This is impossible to do for any other currency pair, for example USD/CHF 1H. In relation to USD/CHF 
there would be no indication that TS1 was launched into operation. The strategies are valid only for a specific 
currency pair.  
 
          Let’s assume that the user has launched Trading Strategy TS1 to trade on the EUR/USD 1H chart from 
account ACC.001. In this case, TS1 is switched to the Automated Trading mode to access account ACC.001. It 
is now impossible to launch any other trading strategy in the Automated Trading mode. To avoid conflict 
between different Trading Strategies, the VT Trader error monitoring system will not allow such action. 
However, the Recommendations mode can be applied to any other Trading Strategy, even for the same price 
chart. In this situation only one Trading Strategy may be launched in the Automated Trading mode for account 
ACC.001. 
  
 So we can avoid conflict between different Trading Strategies if they try to access the same currency 
pair in the same account simultaneously. At the same time the Recommendations mode can be applied to any 
Trading Strategies that are not linked to the user’s manual. 
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When any Trading Strategy is attached to the chart, this would be signaled by the VT icon  in the 
SYSTree. Different VT icons would indicate different states of the Trading Strategy: 
         
     

The icon indicates that there are no attached Trading Strategies.  
 
    The icon indicates that there is at least one attached Trading Strategy. 
  
   The icon indicates that there is at least one attached Trading Strategy and at least one of them is in the 
Recommendations mode. 
  
    The icon indicates that there is at least one attached strategy and at least one of them is in the 
Automated Trading mode. 
 
 Now we will discuss the decision-making process required to estimate if the condition is true on “Each 
Tick.”  
                    
 

The formula for “Each Tick” decisions 
 
 

 It should be clear to the user how decision-making according to the “Complete Bar” formula should 
work. The trading system waits until the chart bar is completed and only at that point makes the decision 
whether a given condition specified in the TS is true or false. 

 
However, when a situation arises requiring the system to make a decision before the bar is completed, 

the situation is a bit more complicated. 
 
Let’s first take a quick look at some fundamental basics about chart bars. 
 
The price information consists of tick values (time, price) and they are not scaled. Originally, the 

principle that “we have something when we have it” was applied. This was inconvenient because although it 
was possible to link the prices with the temporary time scale, eventually the price chart looked unconvincing 
and inconvenient for the purposes of analysis.  

 
To make it easier to understand, the ticks were transformed into separate bars.  
Look at your chart. 
  
The resulting chart bars are closely linked to the time scale and reflect the most important information 

regarding High, Low, Opening, and Closing prices. This approach allows for the filtering out of unwanted 
values inside the chart bar and takes into consideration only such values that are important to estimate price 
within a given time period. This is how bar charts were developed. Under this approch an hourly period in each 
bar reflects only the important price data for each hour, just as a daily period reflects only the important daily 
price information;this is true for all time periods. So, switching from one scale to another the user can evaluate 
and analyse the price movement history during a more extended period while the number of bars on a chart 
remains the same. 

 
The last chart bar that is forming during a certain period of time may be called a “live” bar. Each new 

price value may result in the changes of high and low prices, and in particluar, the closing price that is more 
frequently used to calculate indicators and Trading Systems. So, quite naturally we face an important question:  

 
When should a decision regarding a trading transaction be made if an individual bar is not yet 

completed? 
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It is one thing if this decision is to be made by the user at his own risk. It is very different when a 
“disciplined” and unemotional decision is to be made by the TS. 

  
 
 
 
 
Nearly every trader has seen “long” and 

“attractive” bars that are useless when a timely 
decision based on the closing prices was to be 
made. 

 
Look at the chart to the left. Measure the 

price movement in pips. Calculate the result if the 
minimum size of transaction is 100000$. 

 
Are you impressed? 
 
This movement occurred within 2 hours and 

is displayed in the 4 hour frame.  
 
 
 
The signals that you see on the chart image 

were generated by the attached Moving Average of 
Relative Strength” Trading System described for the 
purpose of example in this manual. 
 
  Consequently, the developers of the VT 

Trader system foresaw such situations and offered the user several “Each Tick” formulas. 
 
 To help illustrate this concept, turn on any price chart with a 10 or 15 minute time period, and build any 
indicator. Increase the scale of the chart to the maximum. Observe how the indicator readings change 
reflecting the formation of the chart bar as price quotes keep coming in. This is particularly easy to visualize 
when you look at the moving tip of the bar. 
 
 Similarly, the condition specified in the Trading Strategy is recalculated depending on the parameters of 
the last “live” bar. Because the condition may be either true or false, the process of decisions made based on 
this bar may be expressed by a succession of zeros and 1’s: 
  
OPEN…000000110000011111000……..00001111000111111111111111111111111…CLOSE 
 
 In this formula, 0 means the condition is false, and 1 means the condition is true. Respectively, the 
action attached to the condition is either taken or not taken.  
 

But such chart bar cannot be used on a permanent basis for decision-making (e.g. to open positions 
each time time the condition is equal to 1, and close when it is equal to zero). This approach would deplete the 
user’s account. 

 
That is why the following formula for making final decisions in the “Each Tick” mode is proposed. 
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Each parameter, to which some action is assigned, is characterised by an “EventCount.” This is a 
complete numeric value prompting the Trading Strategy with regard to the number of successive 1’s that must 
appear in order to define a true/false condition before the final decision is made based on the “live” bar.  

  
This approach relates to all “Output” parameters of the Trading Strategy for both Recommendations 

and Automated Trading modes. The above mentioned “EventCount” parameter is set by the user on an 
individual basis, depending on the time scale, volatility of the currency pair and the principles, on which the 
Trading Strategy is based. This strategy can be tested on VT Trader’s demo mode.  
  

As an example, let’s say the “EventCount” parameter is set to 7. Then, the Trading Strategy analyzes 
all incoming price values, and if it finds a succession of seven 1’s, the condition on this bar is deemed “true” 
and the action is carried out. As a rule, this is sufficient to ensure the stable operation of the entire parameter. 
It is not advised to lower the sensibility threshhold that triggers the condition: 

  
000000000101010001010100011111110101111111111101111111111111 

 
This approach also ensures that the condition is not triggered by accident and allows occasional price 

spikes to be filtered out. If after the condition was triggered the “live” chart bar displays a succession of seven 
zeros, the action is cancelled , and the system begins waiting for a succession of seven 1s that again triggers 
the system’s action: 
 

00000000010101000101010001111111010110000000110111111111111 
 

  Considering that the trading systems’ formulas already contain different market noise filters such as the 
Moving Averages, such situations will not occur frequently. 
 
 If the Output parameter calls for action to be taken, it is necessary to approach the issue of selecting 
the “EventCount” parameter in a very careful manner. The annex to this manual contains the formula for 
choosing the optimal value of this parameter. 
 
 The end of the bar chart formation serves as an additional protection against an accidental trigger. The 
closing price determines the outcome. Here the priority accorded to the last value (0 or 1) is very important. As 
soon as the system completes the bar, the final check of the condition is performed. If the condition was 
triggered by a “live” bar but the chart bar ended with a zero, then the condition is canceled. If the condition is 
confirmed at closing, then it is finally accepted and no further action occurs. Cosequently, if the condition was 
not triggered during the chart bar formation but the bar ended with a 1, a decision is made for a true condition, 
and the action is taken. 
 

This is an example where there was a condition and it was accepted. The action is completed: 
 

000000000101010001010100011111110101111111111101111111111111 
 

Here, there was a condition but it was not accepted. The action was taken and stopped: 
 

000000000101010001010100011111110101111111111101111111111110 
 

Here, there was no condition and it was not accepted. The action never gets taken: 
 

0000000001010100010101001001101010001010111101100000100111110 
 

 
In this case, there was no condition, but there was acceptance. The action was taken: 
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0000000001010100010101001001101010001010111101100000100111111 
 

 
Very often the CROSS function is used to implement the condition for opening a position. It is very 

important to understand that when a succession of 1’s occurs in “EventCount,” it triggers the opening of a 
position in the specified direction, and a succession of zeros in a “live” chart bar will trigger the order for closing 
this position. This position will not always turn out to be profitable, but such actions are not hazardous. This 
can be seen as payment for a timely entry into the market. That is why it is necessary to understand that 
several openings and closings of a position may be triggered on a “live” bar. However, this would have more to 
do with the right selection of the “EventCount” parameter, and correct and careful consideration of the Trading 
Strategy’s script. All Trading Systems supplied with the master copy of VT Trader are open for examination, 
and you can always study them.  

 
If you encounter difficulties while writing the script of the TS, you can ask the experts in our analytical 

department for help. They will be glad to assist you. 
 
 

The “ Time Discretization” decision-making formula 
 
 

In this decision-making mode 
 
Some changes should be made to the formula  
On “live” chart bar  
Calculator displays value equal to 3 ticks 
 
....0001010111 (there is a signal, and the position is triggered)  
000 (the signal and the symbol are gone, but the position remained open) 
010111 (the signal occurs, but the position is not opened) 
010101010111 (this combination is evaluated taking into consideration the previous bar; if 000 appears it will 
disappear)  
(and further until the end of the bar, if at the end it indicates at least 001 in relation to the previous bar; the 
symbol will appear and would be attached to the closing price 
if not, there is 0 and the symbol is not attached; it does not matter if the position opening was triggered)  
 
 
 

(Check out the chain: VT Navigator-> Options -> Properties ->General -> General Properties -> History 
Length ->500) 
 
this parameter may be reduced  
to around 250 
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Additions to the Release 
 

New Possibilities of System Builder 
 

After reading this manual, you may notice certain changes in the newest release of Visual Trading in 
the windows of the Trading Strategies Builder, which provide additional possibilities for creating Trading 
Systems. However, this will in no way influence the systems that you had previously constructed, including the 
system created according to this manual. 

 
What is the main difference? Based on users’ requests, both internal and external improvements have 

been made. Internal improvements include the extension of the syntax of the language of Visual Trading that is 
described later in this manual, and the formulas of trading strategies’ signals and their operation under different 
market situations and modes of connection to the server, and other improvements related to the internal 
nucleus of the Trading Platform. External improvements include additional bookmarks, fields and switches that 
make the Strategy that you create more responsive to the requirements of the most demanding user. 

 
So, let’s start from the beginning. Earlier in the manual, based on an example, you created the Moving 

Average of Relative Strength Index indicator. Then it was analyzed to estimate whether it was correct and 
effective at generating signals, and using this indicator and its signals as a foundation, the link to specific 
actions of the trading platform was established. Thus your first Trading Strategy using Moving Average of 
Relative Strength System was created on the Visual Trading platform. 

 
Here we will make step-by-step improvements to this strategy. Please follow closely all instructions 

while we give the necessary clarifications. 
 
Open the EURUSD 60m chart to full screen and remove all indicators and oscillators that were 

previously brought up as well as all other chart drawings. Let the chart be clear. 
 
Then open the Trading Strategies editor.     
 

 
 

VT Navigator -> Tools -> Trading Systems->… 
 

Open the editor window 
 

Edit Trading Systems-> .. 
 
 
 
 

 
 
 
 

Inside the window, find and select Moving Average of Relative Strength System Trading System 
created with the rules of this manual and press “Edit” to bring it up for editing. 
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Edit Trading Systems-> Moving Average of Relative Strength System -> Edit ->… 

 
 
 
 
 
 
 
 
 
 

 
Move to the “Formula” bookmark. 

 
…->Studies Editor ->Formula.. 
 

 
 
 
 
 

 
 

 
 
Insert a new block into the System’s code. Explanations for these actions will be given later. Do not 

forget that this manual’s Strategy example is used solely to demonstrate the possibilities of the Trading 
Strategy Builder.   

 
{Trend Up and Down} 
 
UpTrend:=not Err and MA1>MA2; 
DownTrend:=not Err and MA1<MA2; 
 
If you carefully examine the block, you will see that “not Err” (taken from the above main part of the 

manual) allows us to check whether the entered parameters of the Moving Averages and RST period are 
correct, and the UpTrend variable is equal to 1 (or to a true meaning), when MA1 is greater than MA2, or equal 
to 0 (or false meaning) when this condition is not met. 

 
The DownTrend variable will be equal to 1 (or have true meaning) when MA1 is less than MA2, and to 0 

(or false meaning) when this condition is not met. 
 
Later, a certain action of the Trading System will be assigned to these variables. There can be any 

number of variables and we recommend using your computer to full capacity and assigning a variable to each 
desired action. This will allow more flexibility in managing the TS when they are ready, and during the testing 
phase to control all variables and correct possible mistakes. Later we shall demonstrate this. 

     
 
Now you may copy the final code of the Strategy from the text of the manual and insert it into the 

“Formula” graph instead of the existing one.  
 
Here’s the code: 
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{Beginning of script…} 
 
{Control Error} 
 
Err:= (PerMA1=0 or PerMA2=0 or PerRSI=0) or (PerMA1>=PerMA2); 
 
{Relative Strength Index} 
 
RSI_r:= (CLOSE - ref(CLOSE,-1));  
RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),PerRSI) /                 
Wilders(if(rsi_r<0,Abs(rsi_r),0),PerRSI);  
RS:= 100-(100/(1+rsi_rs)); 
 
{Moving Average of Relative Strength Index} 
 
MA1:=MOV (RS, PerMA1, E); 
MA2:=MOV (RS, PerMA2, E); 
 
{Signal Long and Short} 
 
Long:=not Err and CROSS (MA1, MA2); 
Short:=not Err and CROSS (MA2, MA1); 
 
{Trend Up and Down} 
 
UpTrend:=not Err and MA1>MA2; 
DownTrend:=not Err and MA1<MA2; 
 
{OpenBuy and CloseBuy} 
 
OpenBuy:=not Err and Long and (eventCount('OpenBuy')= eventCount('CloseBuy')); 
CloseBuy:=not Err and Short and (eventCount('OpenBuy')>eventCount('CloseBuy')); 
 
{OpenSell and CloseSell} 
 
OpenSell:=not Err and Short and (eventCount('OpenSell')= eventCount('CloseSell')); 
CloseSell:=not Err and Long and (eventCount('OpenSell')>eventCount('CloseSell')); 
 
 
{End of script…} 
 
 
To check whether the entered code is correct you may press “OK”, and in case there is no error report, 

again bring up the TS for editing. If the system issues a warning, press the “Cancel” button in the report 
window, and carefully edit the Strategy’s code. 

Move to the “Output” bookmark. 
 

 
…->Studies Editor ->Output.. 
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Operating according to the chains below 
specify new variables and assign to them the 
required actions of the Trading Strategy. You 
will be given necessary explanations. 
 
 
 
 
For the Long variable: 

 
 Studies Editor -> OutPut -> Long ->Edit->Output Variable… 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Here you can see that there are new bookmarks and a new set of switches called “Trends” and 

“Indicator Output” that were not mentioned earlier in this manual. We remind you that if the switch is on (box is 
checked) a given variable is assigned an action, and if you move to a corresponding bookmark you can tune 
the characteristics of this action. Now we shall employ these features to demonstrate the possibilities of the 
system. 

 
 
For the Long variable turn on the “Indicator Output” switch: 
 

 
 
Output Variable ->Name-> Indicator Output ->ON… 
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Move to the “Indicator Output” bookmark and select the properties: 
 
Output Variable -> Indicator Output ->… 

 
 

…-> Color -> Blue ->… 
 

…-> Line Width -> 0… 
 

…-> Line Style -> default… 
 

…-> Placement -> Addition  Frame1… 
 

 
 
  
 
 

A few things should be explained here. For the Long variable we specified that in addition to a sign 
brought up to the chart (an upward blue arrow in accordance with the manual) the price movement chart will 
also show the values of this variable as a separate indicator, specifically a blue (Color) line (Line Style) of 
certain width (Line Width). But where will it be placed? This will be indicated by a property such as 
“Placement,” where Price Frame will bring the line to the price chart, and Addition Frame will create a separate 
frame under the price movement chart and place the line inside it. Conversely, in this release of the system two 
additional frames can be used to reflect the values of variables in a certain manner. The user must decide for 
himself whether it is necessary to place anything inside the frames depending on the output values of the 
variable and the scale of the vertical line of measurement. Any number of output values of the variables may 
be placed inside one frame, using different ways to mark them on the screen.   

 
Similarly, edit the Short variable. 
 
Studies Editor -> OutPut -> Short ->Edit->Output Variable… 
 
For the Short variable turn on the “Indicator Output” switch: 
 
Output Variable ->Name-> Indicator Output ->ON… 
 
Move to “Indicator Output” bookmark and select properties: 
 
Output Variable -> Indicator Output 
… -> Color -> Red ->… 
…-> Line Width -> 0… 
…-> Line Style -> default… 
…-> Placement -> Addition Frame1… 
 
For the Short variable we specified that in addition to the sign brought up to the chart (downward red 

arrow according to the manual), the price movement chart will show the values of this variable as a separate 
indicator. Specifically, it will be a red (Color) line (Line Style) of certain width (Line Width), placed into the same 
frame, where the values of the Long variable are indicated. In other words, the values of the Long and Short 
variables will be shown in the same frame and will differ in color. 

 
 
Do not complete system editing yet. Input two new variables that we specified in the TS formula. 
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The UpTrend variable: 
 
Studies Editor ->OutPut->New->Output Variable Properties->Name->… 

 
Specify the name of the variable.  
 
…->VarName ->UpTrend->… 
…->Name-> UpTrend ->… 
 
Turn on the actions for it.  

 
…->Trends Enable->ON… 
…->Indicator OutPut->ON… 
 

Set the properties on the corresponding bookmarks. 
 
On the “Indicator Output” bookmark: 
 
Output Variable -> Indicator Output 
… -> Color -> Blue ->… 
…-> Line Width -> 0… 
…-> Line Style -> default… 
…-> Placement -> Addition Frame2… 

 
In such a manner we will place the values of the UpTrend variable in a separate frame (Frame 2). 
 
On the “Trends” bookmark:  

 
Output Variable -> Trends->… 
 
Turn on the graphic indicator of the true/false condition of the variable. 
 
… -> Display Vertical Lines -> On ->… 
 
 
 
Specify the color and the way the zone of the true condition of the 

variable will be reflected. 
 
…-> BackGround -> Blue… 
…-> Pattern -> (choose type)  
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Choose the symbol to be shown inside the zone  
 

…-> Label -> Select Symbol -> 
    -> (choose Symbol –Bull)->… 

 
and the color  
 
 

…-> Label Color -> Black  
 
 
 
Press “OK.”  
 
 
 
 
 
 
 
 
At this point, by the above actions, we assured that while the strategy is operational the values of the 

UpTrend variable, regardless of the Long and Short variables ( they are brought up in a separate frame - 
Frame 1), will be shown in a separate frame - Frame 2 – as a stand-alone indicator, but aside from this in case 
of the true condition (0 and 1, respectively, indicate the false and true condition) this zone will be marked by 
vertical lines with color identification from the bottom of the chart. Soon we shall demonstrate the results. 

 
Insert the variable for DownTrend and assign its functionality. 
 
Studies Editor ->OutPut->New->Output Variable Properties->Name->… 

 
 

Specify the name of the variable.  
 
…->VarName ->DownTrend->… 
…->Name-> DownTrend ->… 
 
Enable actions for that variable.  

 
…->Trends Enable->ON… 
…->Indicator OutPut->ON… 
 

Select properties for them on corresponding bookmarks. 
 
On “Indicator Output” bookmark: 
 
Output Variable -> Indicator Output 
… -> Color -> RED ->… 
…-> Line Width -> 0… 
…-> Line Style -> default… 
…-> Placement -> Addition Frame2… 
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This way we will place the values of the DownTrend variable into a separate frame (Frame 2) together 
with the UpTrend variable: 

 
On the “Trends” bookmark:  

 
Output Variable -> Trends->… 
 
Turn on the display of the true/false condition of the variable. 
 
… -> Display Vertical Lines -> On ->… 
 
Specify color and display of the zone of true/false condition of the 

variable. 
 
…-> BackGround -> RED… 
…-> Pattern -> (choose type)  
 
 
 
 
 
 
 

 
 
 
Choose the symbol for the zone:  
 

…-> Label -> Select Symbol -> 
    -> (choose Symbol- Bear)->… 

 
and its color 
 

…-> Label Color -> Black  
 
 
 
Press “OK”.  

 
 
 
 
 
 

By way of the above actions we assured that whenever the strategy is operational the chart will reflect 
the values of the DownTrend variable regardless of the Long and Short variables (they are also shown in a 
separate frame - Frame 1) inside a separate frame - Frame 2 – as a separate indicator together with the 
UpTrend variable, but aside from that if the condition is true (0 and 1, respectively, stand for false and true 
condition) a zone will be marked by vertical lines and highlighted from the bottom of the chart.  
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Now everything is ready for further steps. Follow the chain: 
 
Studies Editor ->OutPut->OK->… 
 
Provided there is no error message close the trading strategies editor. 

 
Edit Trading Systems ->Close->…. 
 
 
Using the context menu and the commands that you know, build the “Moving Average of Relative 

Strength Index” indicator directly from the price chart (EURUSD 60m, bid). 
 

Chart EURUSD 1H -> right Bottom -> Add Studies -> Moving Average of Relative Strength Index -> OK … 
 

And launch the Moving Average of Relative Strength System strategy that you have created and edited 
in accordance with these Additions to the trading manual. 

 
 

Chart EURUSD 1H -> right Bottom -> Add Trading Systems -> Moving Average of Relative Strength System -
>(I Agree) ->OK … 

 
 

 
 
 
 
 
 
 
 
 
 
If you have followed the above recommendations the price chart will show the EURUSD 60m price 

movement, below it in a separate frame the Moving Average of Relative Strength Index indicator that we built 
that is used as a foundation by the attached Moving Average of Relative Strength System trading strategy, and 
at the bottom - Frame1 containing the values of the Long and Short variables that are calculated using the 
following formula: 

  
{Signal Long and Short} 
 
Long:=not Err and CROSS (MA1, MA2); 
Short:=not Err and CROSS (MA2, MA1); 
 
And below inside Frame2 the values of the UpTrend and DownTrend variables, calculated as follows: 
 
{Trend Up and Down} 
 
UpTrend:=not Err and MA1>MA2; 
DownTrend:=not Err and MA1<MA2; 
 
It is important to understand that it is not necessary to place these exact values of the variables on the 

price movement chart together with the display of the trading strategy. In this manual that is done only with the 
purpose of demonstrating the possibilities of the Trading Systems Builder and show the differences between 
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the comparison functions and “cross” language functions, since this particular question is frequently raised by 
the users. Such approach allows you to monitor the value of any variable in the TS formula by placing it on the 
screen together with the attached strategy.   

 
 
Note that the “cross” function is displayed in impulses while the comparison function is more 

comprehensive, i.e. remains true until the values of the variables become false. 
 
 

 
 
 

Examine the above screenshot and the developed trading strategy. If some elements do not seem 
logical, re-read this manual. This trading system will be exported, and you will be able to download it from the 
developer’s site at any time as an example together with this manual. 
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If everything is clear, here is a small test to verify your knowledge. 
 
 
Test: 
 
 
1. In this TS turn off the display as indicators of the Long, Short, Uptrend and  Downtrend 

variables.  
2. Bring up the МА 1, МА2 and RS variables to the screen as an output indicator, so that it 

would appear together with the TS and there would be no need to build the Moving Average 
of Relative Strength Index indicator by standard means.  

 
 
You may use as an example the VT- Moving Average of Relative Strength Index System trading 

strategy that was demonstrated to you earlier and supplied with the standard release. 
 

In other words, based on new possibilities change your system so that it would follow the example. 
 
We hope you have success in building strategies and good luck. Any response and new suggestions 

will be appreciated. 
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Addition to the Release 
 

How the Trailing Stop System Works and How to Apply It 
 
 
Most of the users are probably familiar with the concept of Trailing Stop and, moreover, have used this 

technique in their trading.  
 
Many traders believe that trailing stops can provide guaranteed insurance against losses in the market. 

In our view, this is not always the case. Truly, trailing stops are convenient instruments, but they require that 
the user fully understands how it works and uses it with discretion. 

 
 
 
 
 

 
 
 
 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Trailing Stop system allows the user to trail the market with a protective set-up (Stop Loss) from 

the level where it was set (Set Stop Loss) for an open position (Open Buy) and at a certain distance from the 
price (N).  
 
  On the chart above it can be seen the Trailing Stop level meticulously follows the closing price of the 
bar at a distance of N, ignoring occasional price spikes, if the price moves in the direction of the open position: 
 

(Close-Trailing Stop) > N . 
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 Also, it does not change the level when the price movement is less than the set N value:  

 
(Close-Trailing Stop) < N  

 
The Trailing Stop is ready at any moment to close a position and take profit, if the market turns around. 

 
 What distinguishes a savvy trader is his ability to determine the right N value for a specific chart scale. If 
the trader plans to trade on a tick-by-tick chart, then the Trading System must be launched on a tick-by-tick 
chart.  
 

The Trailing Stop Loss, supplied with the Visual Trading System is based on tracking the price level and 
allows the user by way of experimenting and analyzing to determine the right N value. The indicator plots the 
line showing the best Stop level for a given N value.  

 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
It is recommended that you carefully study this indicator. The logic of this indicator can be used to 

create proprietary systems, designed both to monitor profits and control losses. 
 
Different ideas have been studied in conjuncture with the concept of Trailing Stop. In this manual we 

will explain the logical formula incorporated into the Trailing Stop System Trading Strategy. 
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In order for the system to operate, the user must have an open position, e.g. BUY on a Demo, to which 
he wishes to attach a Trailing Stop System.  Please, the standard means to bring up the VT-Trailing Stop 
System Trading Strategy: 

 
  

 
Chart (Chart EURUSD 1H) -> right Bottom -> 

Add Trading Systems -> VT-Trailing Stop System 
->…  

 
 
 
 
 
 

 
…-> read the text and click “I Agree” ->OK … 

 
A panel will open up where you will enter the strategy’s parameters:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

In the space “Stop Price for Open Position” enter the initial desirable stop level (Set Stop Loss) for your 
open position, using a quote from the chart:  
 

 
 

 -> Stop Price for Open Position -> … (quotes) 
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*if you set the initial level above (in this particular case - versus below for the SELL position) than the market price 
at the moment when the system is launched, than in any case the TS shall operate only from this level. In this case the 
Trading Strategy may be used not only as a Trailing Stop, but also as a Limit Profit. If this level is surpassed the TS shall 
begin monitoring the level as a Stop from the current level, but it will not “allow” the price beyond its level. In other words, 
if the price moves further, it will be trailed, if not it will be stopped. 
 
 

In the “Open Position Direction” field choose the direction of your open position from the list. If the 
system issues an order it will be in the opposite direction:  
 

-> Open Position Direction -> … (Buy or Sell) 
 

 
 
 
 
 
 
 

 In the field “Stop Step” (N-Pips Trailing Stop) specify the value that will be the distance, at which the 
Trailing Stop will follow the price.  
 

 
 

-> Stop Step -> … (delta quotes) 
 
 
 

 
Please be aware that for the example for EUR (GBP, CHF, etc.) Stop Step = 0.0050 is equal to 50 pips, 

whereas for JPY 50 pips will transfer into 0,50.  
 
Press “OK.”   
 
The chart will display the results of the calculations performed by the Trading Strategy. The plotted line 

moves from the level, at which the Stop was set, to the zone in the bottom part of the chart.  
If necessary, change the parameters of the Trading Strategy by bringing it for editing. After the 

properties are set do not forget to launch the strategy for execution. The system will take action only once. To 
use it further it has to be restarted. 
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